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Preface

DEC SoftPC is a software program that allows your Digital
workstation or terminal to emulate an IBM PC. With DEC SoftPC
software on your system, you can use PC and MS-Windows
applications.

Purpose of This Guide
This guide describes how to use the DEC SoftPC software, Version
4.0, on a Digital VT220 terminal or on Digital workstations that
use the VMS operating system.

Who Should Use This Guide
This manual is intended for Digital system users who want to
use MS–DOS applications. You should be familiar with MS–DOS
software and with Motif software.

Structure of This Guide
This guide contains the following chapters and appendixes:

• Chapter 1 describes the features and benefits of DEC SoftPC.

• Chapter 2 describes how to start DEC SoftPC and open a DEC
SoftPC window on a workstation.

• Chapter 3 describes the emulated hard disks, C: and D: and
the emulated networked drives, E: through Z:.

• Chapter 4 explains how to load application software into DEC
SoftPC.

• Chapter 5 describes how to use floppy disks on your
workstation.

• Chapter 6 explains how to add printers and modems to your
system and how to print DEC SoftPC files.
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• Chapter 7 discusses graphics interfaces and both expanded
and extended memory.

• Chapter 8 describes file sharing between the MS–DOS and
VMS operating systems.

• Chapter 9 describes how to configure a terminal to run DEC
SoftPC and how to use DEC SoftPC on that terminal.

• Chapter 10 has hints on using DEC SoftPC and answers to
frequently asked questions.

• Appendix A contains step-by-step instructions for installing
DEC SoftPC for VMS.

• Appendix B lists and explains the messages you could receive
from MS–DOS and DEC SoftPC.

• Appendix C lists and describes each file in the Insignia
subdirectory under DEC SoftPC.

• Appendix D describes serial port emulation for
communications packages and printers.

• Appendix E discusses file protection on VMS systems.

• Appendix F illustrates how Digital workstation keys are
mapped to a PC. It also explains how the Digital mouse is
equivalent to the PC mouse.

For More Information
For more information on DECwindows and the MS–DOS operating
system, you can order the following manual through DECdirect.
Call 1-800-DIGITAL.

• MS–DOS Reference Manual (Order Number: AA–LB–62A–
TE). This manual describes the MS–DOS operating system
and commands.
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Conventions
The following conventions are used in this manual:

Return In examples, a key name is shown
enclosed to indicate that you press a
named key on the keyboard.

Ctrl/x A sequence such as Ctrl/x indicates
that you must hold down the key
labeled Ctrl while you press another
key or a pointing device button.

Note Notes provide general information
about the current topic.

mouse The term mouse refers to any
pointing device, such as a mouse,
a puck, or a stylus.

MB1, MB2, and MB3 MB1 indicates the left mouse button.
MB2 indicates the middle mouse
button. MB3 indicates the right
mouse button.

Color Text in color indicates user input.

$ The VMS prompt.

> The DOS prompt.

UPPERCASE DOS commands.

xi



1
Overview

DEC SoftPC is a software program that lets your workstation
or terminal run DOS applications as though the workstation
or terminal were an IBM Personal Computer (PC). No special
hardware is required.

DEC SoftPC software uses the Motif or the VT220 user interface
to the VMS operating system.

DEC SoftPC System
With DEC SoftPC you get a system that feels like a PC, including:

• Keyboard

• Mouse

• Screen display: CGA, Hercules, EGA, VGA, or Super VGA
mode on a graphics workstation and MDA mode for a VT220
terminal

• C: and D: Winchester drives of variable sizes up to 300 Mbytes

• COM1, COM2, COM3, COM4, LPT1, LPT2, and LPT3
communications ports

• 80287 floating-point coprocessor

What DEC SoftPC Can Do
With DEC SoftPC you can:

• Execute MS–DOS commands

• Cut and paste between MS–DOS windows and Motif windows

• Share files with other users on the network

• Transfer files between MS–DOS and the VMS operating
system and vice versa
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• Run MS–DOS and Windows applications

• Simultaneously work with applications based on MS–DOS in
one window and applications based on VMS in other windows

• Network with other workstations running DEC SoftPC

• Run multiple DEC SoftPC windows

Features
DEC SoftPC is a software emulation of an IBM PC AT with an
Intel 80286 CPU and an Intel 80827 math coprocessor. DEC
SoftPC has the following features:

• Freeze option

The Freeze option allows you to put an MS–DOS application
on hold, release the CPU to return to the VMS environment,
and then run an VMS application. With a few mouse clicks
you can resume your MS–DOS application.

• VGA compatibility

The DEC SoftPC screen can emulate a VGA-compatible
display.

If you are installing applications software on a VT220, you
must enter MDA.

• Access to 32 Mbytes of memory

DEC SoftPC emulates the LIM Expanded Memory System
through the EM_DRVR.SYS driver. MS–DOS applications
such as Lotus 1-2-3, Microsoft Windows, and DESQview can
access a block of memory containing up to 32 Mbytes.
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• Nonvolatile RAM emulation

The PC AT holds nonvolatile RAM on a low-power
consumption CMOS chip. DEC SoftPC emulates this feature
with a file, SPCCMOS.RAM. This file includes information
about the size and density of disks, the amount of LIM
memory, and the real-time clock. If DEC SoftPC does not find
a SPCCMOS.RAM file in your home directory, it creates a
default version.

Note

DEC SoftPC may create a CMOS.RAM file in your home
directory.

DEC SoftPC Version 4.0 Enhancements
DEC SoftPC Version 4.0 has the following enhancements:

• Motif-based user interface

• Support for protected-mode operation (this also means support
of Windows Version 3.1 Standard Mode)

• Super VGA (256 colors)

• Autoflush availability (flushing occurs 1 to 50 seconds after
the buffer is loaded)

• FPU emulator (ability to turn on and off the hardware
floating-point emulation)

• Menu-driven keyboard mapping

• Extended and expanded memory

• Support for Microsoft CD–ROM extensions

• Multiple window sizes

• Support for both A: and B: floppy drives

• Support for hard disks up to 300 Mbytes

• Support for MS–DOS 5.0
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2
Using DEC SoftPC on a Workstation

This chapter describes how to:

• Start DEC SoftPC

• Use the pull-down menus

• Save files and exit DEC SoftPC

• Increase the DEC SoftPC window size

• Use the mouse in an MS–DOS window

• Use the mouse in a VMS window

• Cut and paste

• Perform a full MS–DOS reboot

• Stop the MS–DOS process

• Switch the sound on and off

• Switch the FPU Emulation on and off

DEC SoftPC installation instructions are in Appendix A.
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Start DEC SoftPC
To start DEC SoftPC from the VMS prompt, enter:

$ SoftPC

Result: The DEC SoftPC window is displayed.

MLO-010620

Digital Equipment Corporation. V4.0 1992.  All Rights Reserved.

 
 
 
 
 
 

Num Lock

File Options Actions

VGA

SoftPC

SoftPC
(c) Copyright 1992 by Insignia Solutions Inc.  All rights reserved.

SoftPC Expanded Memory 3.01 installed (128 pages)
SoftPC FSA Redirector 3.02 installed

SoftPC MSCDEX Device Driver Version 1.2
Copyright 1992 by Insignia Solutions Inc.  All rights reserved.
Device Name      :CDROM$$$

SoftPC Mouse 3.01 installed
C:\>_

(You can also install DEC SoftPC to run as a Motif menu item.)

Note

If you are using DEC SoftPC with a floppy disk drive and
start DEC SoftPC without a physical floppy disk in the
drive, some versions of VMS appear to stall. DEC SoftPC
might take up to 75 seconds to start.
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Use the Pull-down Menus
The menu bar at the top of the window contains the words: File,
Options, and Actions. Each word represents a pull-down menu
that you display by using the mouse.

There are two ways to use a pull-down menu:

• Drag method: Point to the menu you want, press MB1, drag
the pointer to highlight the desired function, and release MB1.

• Click method: Point to the menu you want, click once to
display the menu, point to the desired function, and click
again.

If you decide not to choose a function after the menu is displayed,
move your cursor off the menu and click.

SoftPC

File Options Actions

A: EGA

Exit...

MLO-007274
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Save Files and Exit DEC SoftPC

File

Exit...

Exiting DEC SoftPC is like turning off a PC. To save your
configuration file and exit:

1. From the File menu, select Exit.

Result: This warning is displayed.

2. Click on OK. Or, if you do not want to save your files, click on
Save Configuration Changes to remove the default.

CancelOK

Warning

MLO-008644

SoftPC Exit

This will end the current SoftPC session. 
Save your work before you exit the SoftPC.

Save Configuration Changes

Enlarge the DEC SoftPC Window
To increase the size of the DEC SoftPC window to 1 1/2 or 2 times
the size of the original window:

• Place the cursor on the edge of your window, hold down MB1,
and drag the window, either horizontally or vertically, as
desired.

If you have problems enlarging the DEC SoftPC window, you may
need to change the pixel display.

Use the Mouse in an MS–DOS Window

Flush Ports

Activate

Attach Mouse

Freeze

Restart

Actions To use the mouse in an MS–DOS window:

• From the Actions menu, select Attach Mouse.

If you are not using a DOS mouse-based application, your cursor
disappears. To restore your cursor, simultaneously press
Ctrl/Alt/MB2. (Depending on your Digital keyboard, Alt may be
Compose Character or left Alt.)
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OK

Information

MLO-008640

Mouse Detachment

 To detach the mouse from SoftPC,
use Ctrl + AH + middle mouse button.

Use the Mouse in a VMS Window
To use the mouse in an VMS window:

• Simultaneously press Ctrl/Alt/MB2. (Depending on your
Digital keyboard, Alt may be Compose Character or left Alt.)

Cut and Paste
To cut and paste between windows:

1. Place the cursor at the start of the text you wish to cut, hold
down MB1, and drag the cursor to the end of the desired text.

Result: The text will be highlighted.

Release MB1.

2. Move the cursor to the exact place in another window where
you want to paste the text. Click on MB2 to paste.

Perform a Full MS–DOS Reboot

Flush Ports

Activate

Attach Mouse

Freeze

Restart

Actions Some MS–DOS applications do not provide a software exit but
expect the user to either reboot the PC by pressing Ctrl/Alt/Del
or to switch the PC power off and on again. To perform a full
MS–DOS reboot with DEC SoftPC:

• From the Actions menu, select Restart.

• Or, from the DOS prompt, simultaneously press Ctrl/Alt/Del
for a conventional DOS restart.
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Stop the MS–DOS Process with Auto Freeze or Freeze
Auto Freeze and Freeze save processing time if you run several
window sessions simultaneously. Both permit you to stop the
DEC SoftPC window from using CPU cycles and allow a second
application to continue running.

The difference between Auto Freeze and Freeze is that Auto
Freeze stops the process when you select another window and
Freeze stops the process immediately.

Auto Freeze

Disk Drives

COM/PLT Ports

Display...

Keyboard...

Memory...

Auto Flush...

Auto Freeze

Sound

FPU Emulation

Options Consider using Auto Freeze if your workstation is slow when
you use multiple windows. The reason may be that DEC SoftPC
does not always detect when a PC application is idle. You could
also check the CPU usage to see if DEC SoftPC is running
continuously. This is very important when running MS-Windows.

To stop running an application when you leave a window:

• From the Options menu, select Auto Freeze.

Freeze

Flush Ports

Activate

Attach Mouse

Freeze

Restart

Actions To stop running an application immediately:

• From the Actions menu, select Freeze.
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Switch the Sound On and Off
A Digital workstation does not have the sound capabilities of a
PC. To suppress the sound that some applications may have:

• From the Options menu, select Sound.

Switch the FPU Emulation On and Off

Disk Drives

COM/PLT Ports

Display...

Keyboard...

Memory...

Auto Flush...

Auto Freeze

Sound

FPU Emulation

Options A Digital workstation has 64-bit floating-point hardware while
a PC has 80-bit hardware. DEC SoftPC can compensate for this
hardware difference.

If your application requires 80 bits, turn the FPU (hardware)
Emulation off. This allows DEC SoftPC to emulate 80 bits.

If your application does not require 80 bits, turn the FPU
Emulation on. This will greatly increase the speed of DEC
SoftPC.

If your application does not require floating point emulation, you
can turn the FPU Emulation either on or off.

• From the Options menu, select FPU Emulation.
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3
Hard Disks and Drives

Background
Users typically copy MS–DOS applications from floppy disks onto
a hard disk because hard disks are faster and larger. This chapter
shows how to use the emulated C: and D: hard disk drives or
Drives E: through Z:.

You can create or copy as many hard disk container files as your
file system space permits, but you can use only two (C: and D:)
at a time, plus the File Sharing Architecture (FSA) drives, E:
through Z:.

Names of MS–DOS Drives
Disks are identified by their drive letters. You must use the drive
letter to access the disk as shown below.

Drive Name Disks Accessed

C: and D: Emulated hard disks

E: through Z: Emulated networked disk drives

Drives C: and D:
DEC SoftPC represents hard disks as large container files on
Drives C: and D:. DEC SoftPC handles these emulated disks (C:
and D:) as though they were PC AT internal hard disks. You must
be in DEC SoftPC to access the MS–DOS files contained on an
emulated hard disk. They cannot be seen individually by using
the VMS DIR command.
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Drive C:
Drive C: is a file that initially represents 3 Mbytes of hard disk
(including MS–DOS). You can, however, have a drive C: up to 300
Mbytes. You do this by making a new hard disk. See Creating a
New Hard Disk later in this chapter for instructions. The name
of the original file is 3MB.HDF. This file contains MS–DOS, GW
BASIC, and Insignia utilities and drivers.

Drive D:
Drive D: does not initially exist. You must create Drive D: if you
need it. See Creating a New Hard Disk later in this chapter for
instructions.

Drives E: through Z:
DEC SoftPC has software known as FSA that allows you to use
Drives E: through Z:. Each drive is similar to a networked drive
on a real PC, but in fact is a VMS directory. These drives look like
regular hard disks to MS–DOS.

Files in E: through Z: can be shared between native VMS and PC
applications. The drives can be local or remote. Drives E: through
Z: are called FSA Root Directory on the options menu.

CD–ROM Drive
DEC SoftPC provides the ability to attach a CD–ROM drive
(RRD42). To use a CD–ROM drive, the Microsoft Extension
MSCDEX.EXE must be used. See Using the CD–ROM later in
this chapter for more information.

Sharing Files
Be careful when simultaneously sharing hard disk files between
workstations. DOS does not handle simultaneous file sharing in
a foolproof manner. Sharing files might lead to corrupted files.
There is no problem if your intended useage is read-only.

Creating a New Hard Disk Container File
You can create a new C: or D: hard disk by:

• Copying an existing hard disk

• Creating an empty hard disk and formatting it. (You can put
MS–DOS on the disk.)
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Copying is easier, but your disk size is limited to the size of the
original disk. Creating a new disk allows you to adjust the size to
your requirements.

Copying an Existing Hard Disk
Enter:

$ COPY HARD.DISK NEWHARD.DISK
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Checking Your Current Disks

• From the Options menu, select Disk Drives, then New Drive.

Result: These menus are displayed. In this example, there
is a C: drive named 3MB.HDF, a D: drive named HARD_
DISK.DRIVE, the E: drive points to SYS$LOGIN, the
CD–ROM device is named DKA 400:, and the floppy drive
A: is named DKA300:. Your file names may differ.

Disk Drives

COM/PLT Ports

Display...

Keyboard...

Memory...

Auto Flush...

Auto Freeze

Sound

FPU Emulation

Open Drive...

New Drive...

Options

Open Disk Drives

Hard Disk Drive C:  File Name...

Hard Disk Drive D:  File Name...

FSA Root Directory Name...

Floppy Drive A:  Device File Name

SlavePC Device Name

Replace the real floppy emulation with SlavePC

:

:

:

:

:

Reset CancelOK
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Floppy Drive B:  Device File Name

CD-ROM Device File Name

:

:

3MB.HDF

HARD_DISK.DRIVE

SYS$LOGIN

DKA300:

DKA400:
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The remainder of this chapter describes how to create or
change your current hard disks.

Creating a New Hard Disk
Hard disks can be bootable or non-bootable. You determine which
type you need.

• A bootable disk contains the MS–DOS operating system and
other files. It is known as Drive C:.

• A non-bootable disk contains application programs. It is
known as Drive D:.

Do not make a new C: drive using system files from a C: drive
that contained a previous version of DEC SoftPC.

Step Action

1 Select the size for your new disk.

2 Partition the disk.

3 Choose to create a bootable or non-bootable disk.
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Step 1: Select the disk size

1. From the Options menu, select Disk Drives, then New Drive.

Result: These menus are displayed.

2. Enter the name of the disk. (If you enter a file name, it is
placed in the directory you were in when you invoked DEC
SoftPC. If you enter a full path name, that is where the new
drive [file] is installed.)

3. Place your cursor on the slide bar and move the marker to the
desired size. Click on OK.

The example shown creates a 150 Mbyte container file named
NEWDRIVE.DOS.

Result: The file is created and DEC SoftPC restarts with
NEWDRIVE.DOS installed as your D: drive.
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Disk Drives

COM/PLT Ports

Display...

Keyboard...

Memory...

Auto Flush...

Auto Freeze

Sound

FPU Emulation

Open Drive...

New Drive...

Options

Reset CancelOK

New Hard Disk

SoftPC will automatically assign this new hard disk as drive
D.  After you create the disk, you must run FDISK and
FORMAT to configure the new drive.  This procedure is
explained in the SoftPC User’s Guide.

New File...

1 300

150

New Hard Disk Size (Mbytes)

MLO-009955

NEWDRIVE.DOS
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Step 2: Partition the disk

1. At the DOS prompt, enter:

FDISK Return

Result: The FDISK program is displayed.

2. Enter Option 5 from the FDISK menu for your second hard
disk.

Enter choice [5] Return

Result: ( DOS Version 5.0 only ) The disks on your system are
displayed.

3. ( DOS Version 5.0 only ) Enter the disk number with 0% usage.
Return

4. Enter Option 1 to create an MS–DOS partition.

5. Then, from the following menu, enter Option 1 for a primary
partition.

6. Enter Y to use the whole disk as a standard MS–DOS
partition, unless you have special requirements.

7. Press Esc to return to FDISK options.

8. Press Esc again to exit FDISK.

9. Press any key.

Result: DEC SoftPC will reboot.
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Step 3: Choose to create a bootable or non-bootable
disk
Choose to create a bootable or non-bootable disk, and then enter
the following commands: (The C: drive must be a released version
of DEC SoftPC Version 4.0.)

Step Bootable Non-bootable

1 FORMAT D:/S FORMAT D:

2 Y Return Y Return

3 XCOPY C: D:/S

4 MAKEBOOT 1

Optional Method to Create a Bootable Disk
The XCOPY command shown in Step 3 copies all files from your
existing DEC SoftPC V4.0 C: drive to your newly created D: drive.
If you do not need to copy the entire disk, you may copy only
the following essential files from C: disk to D: disk. To do this,
substitute the following commands for Step 3. Then go to Step 4.

1. mkdir d:\dos Return

2. mkdir d:\insignia Return

3. copy c:\dos\*.* d:\dos\*.* Return

4. copy c:\insignia\*.* d:\insignia\*.* Return

5. copy c:config.sys d: *.* Return

6. copy c:autoexec.bat d: *.* Return

Using Drives E: through Z:
You can use Drives E: through Drive Z: as emulated disk drives;
they can be local or remote.

To do this:

• The DOS CONFIG.SYS files must contain the line
LASTDRIVE=(ID of last drive to be used). Example:

LASTDRIVE=G
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• Your AUTOEXEC.BAT can contain the drive ID and the VMS
directory path. Example:

NET USE F: SOFTPC$SYSTEM

You can also enter this at the DOS prompt.

To detach a drive, enter:

NET USE(DRIVE ID):/D

Example:

NET USE F: /D

To list current drives, enter:

NET USE
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Using the CD–ROM

1. From the Options menu, select Disk Drives, then Open Drive.

Result: These menus are displayed.

Disk Drives

COM/PLT Ports

Display...

Keyboard...

Memory...

Auto Flush...

Auto Freeze

Sound

FPU Emulation

Open Drive...

New Drive...

Options

Open Disk Drives

Hard Disk Drive C:  File Name...

Hard Disk Drive D:  File Name...

FSA Root Directory Name...

Floppy Drive A:  Device File Name

SlavePC Device Name

Replace the real floppy emulation with SlavePC

:

:

:

:

:

Reset CancelOK
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Floppy Drive B:  Device File Name

CD-ROM Device File Name

:

:

HARD_DISK.DRIVE

SYS$LOGIN

DKA300:
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2. Enter the name of the CD–ROM: Example, DKA400.

If you do not know the name of the CD–ROM, enter:

$ SHOW DEV D/FULL Return

The system will display information similar to this:

Disk DKA400:, device type RRD42, is online, file-oriented device,
shareable, error logging is enabled.

CD–ROM drives have a device type of RRD42. In this
example, the name of the CD–ROM is DKA400.

Result: This warning is displayed.

CancelOK

Warning

MLO-007284

SoftPC Restart

This will end the current SoftPC session 
and start a new one.  Save your work
before restarting the SoftPC.

3. Click on OK.

Result: The screen goes blank and the system restarts. The
DOS prompt(>) is displayed.

4. At the DOS prompt, enter:

MSCDEX /D:CDROM$$$ /L:E /M:8 /V Return

Result: This command allows DOS to recognize the CD–ROM
as a single logical drive letter. If desired, you can include
this command in the AUTOEXEC.BAT file so the CD–ROM is
available when the system is booted.

Format of MSCDEX.EXE:

MSCDEX.EXE /D:<device_name> /L:<drive_letter> /M:xx /V
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The terms of the previous command are explained in the table
below.

Term Explanation

/D: The device name that is the same as in CONFIG.SYS
(CD–ROM$$$ in the previous example).

/L The logical drive letter that will be assigned to the CD–ROM
drive.

/M The number of cache buffers (8–15) for MSCDEX.EXE. Each
uses 2048 bytes of RAM; the default is 10.

/V Displays information about MSCDEX.EXE during the boot.

Default Hard Disk
The default hard disk has a directory, Insignia, which contains:

• The mouse driver

• Support for Drive E:

• Microsoft Windows 3.0 drivers for display and mouse

• Insignia versions of the MS–DOS files, CONFIG.SYS, and
AUTOEXEC.BAT, which establish the necessary drivers and
programs

• LIM driver

The CONFIG.SYS file must contain the following lines that allow
the use of VMS files with Drive E; and allow the use of LIM
expanded memory.

DEVICE = C:\INSIGNIA\HOST.SYS

DEVICE = C:\INSIGNIA\EM_DRVR.SYS

If you have a CD–ROM, add the following lines to your
CONFIG.SYS file:

DEVICE = C:\INSIGNIA\CDROM.SYS

DEVICE = C:\DOS\SETVER.EXE
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The AUTOEXEC.BAT file should contain the following lines for
the mouse, FSA, and the CD–ROM:

C:\INSIGNIA\MOUSE.COM

C:\INSIGNIA\FSADRIVE E:

MSCDEX \D:CDROM$$
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4
Installing Applications

DOS applications are typically sold on floppy disks which users
then install (load) into a floppy disk drive on their PC. Your
Digital workstation may or may not have a floppy disk drive. This
chapter describes how to install applications or data using DEC
SoftPC with or without a floppy disk drive.

Initially, all DOS applications must be installed. Once
installed, applications can be copied except for those that are
hardware-specific.

IF you have . . . GO to this section . . .

a floppy disk drive on your workstation Installing from a Floppy Disk

a workstation with DEC SoftPC and a
floppy disk drive on your network

Copying over a Network

a real PC and Pathworks on your
network

How to Use a PC and
Pathworks

no floppy disk available How to Use SlavePC

Installing from a Floppy Disk
Follow the instructions on your application software.

Copying over a Network
You can copy any application that has been already installed
on another DEC SoftPC over a network. Do this by copying the
container file.

You can copy files from, and share files with, other DEC SoftPCs.
Files contained on an FSA drive can be shared by multiple DEC
SoftPCs using the host networking software.

Alternatively, you can copy files to a DEC SoftPC on a standalone
workstation.
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Do not share a DEC SoftPC hard disk; only copy it. A shared hard
disk file can be corrupted.

How to Use File Transfer
You can copy an existing hard disk file to a workstation not on
a network by using any convenient file transfer method, such as
tape. Note that a hard disk drive file is a single file under VMS;
you cannot access the MS–DOS files separately.

Notes

Users are responsible for complying with licensing
requirements when copying container files that contain
licensed applications software.

When transferring files using Kermit, set the file type
to either ‘‘fixed’’ or ‘‘block’’ before doing the transfer.
Otherwise, the transferred file will not be usable.

Copying from a PC
You can use a PC networking package such as PC NFS and the
Insignia filesharing capability to transfer files, the DECnet–DOS
Network File Transfer (NFT) program, or the Pathworks file
service.

To do this:

1. Copy files from Drive C: of the PC to an intermediate directory
in VMS.

2. Give DEC SoftPC access to the files by setting up the File
Sharing Architecture (FSA) drive to be the intermediate VMS
directory. (See Chapter 8 for more information on FSA.)

Be aware of the restrictions on using Drive E:. Copy-protected
applications and some DOS commands may not work.
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About copy-protected applications
The hardware interface on Digital workstations does not allow
you to install copy-protected applications. You can install copy-
protected applications on Digital workstations by:

• Installing the application on a real PC on your network, then
copying that application to your workstation

• Using SlavePC

How to Use a PC and Pathworks
If you have both a real PC and Pathworks on your network,
you can install applications using the File Services portion of
Pathworks.

DEC SoftPC can read and write to the Pathworks file services
directory. You may, however, have simultaneous access problems
because Pathworks does not have byte-range record locking. This
means one user might be reading a record while a second user is
updating or deleting that record.

Follow these steps to install applications using a portion of
Pathworks:

Step Action

1 Transfer a file from the PC to your VMS directory.

2 Go to Drive E: or other FSA drive on DEC SoftPC.

3 From the Options menu, select Open Drive.

4 Enter the name of the FSA Root Directory using the standard VMS
file-naming conventions.

$ PCCOMMON:[DIRECTORY]

Example:

$SYSTEM::PCCOMMON:[DIRECTORY]

Then, using the DOS copy command, copy the document
‘‘filename.doc from your Drive E: to Drive C:.’’

Example:

D> copy E:filename.doc C:*.*
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Drives A: and B:

Description
The floppy disk drive is called either Drive A: or Drive B:.
Generally these drives are used to install PC applications from
floppy disks, to store individual programs, and to make floppy disk
copies of or backup PC files.

Drives A: and B: access:

• RX23 floppy disk

• RX26 floppy disk

• RX33 floppy disk

• SlavePC

Specifications
The RX23, RX26, and RX33 follow standard MS–DOS formats.

Device Density
Disk
Size Storage Size Functions

RX23 DD
( double )

3.5 in. 720 Kbyte Read-write

1.4 Mbyte Read-read

RX26 DD
( double )

3.5 in. 720 Kbyte Read-write

RX26 HD
( high )

3.5 in. 1.4 Mbyte Read-write

RX26 ED
( high )

3.5 in. 2.88 Mbyte Read-write

RX26 ED
( extended )

3.5 in. 2.8 Mbyte Read-write

RX33 DD
( double )

5.25 in. 720 Kbyte Read-write

RX33 HD
( high )

5.25 in. 1.4 Mbyte Read-write
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Figure 4–1 Disk Types

Single Density Double Density Extended Density
MLO-010128

Notes

Q–bus floppy disk drives are not reliable unless formatted
on your drive; therefore, DEC SoftPC does not support
Q–bus floppy disk controllers and drives.

If you cannot read a floppy disk that has been formatted
on another system, reformat the failing disk on the
DEC SoftPC system and use the reformatted disk as
the medium of exchange.

What Is SlavePC?
SlavePC allows you to use a floppy drive on a connected PC.
SlavePC cannot be used as a remote PC.

Since SlavePC allows the floppy disk in a real PC to act as
Drive A: or B: on your Digital workstation, you use SlavePC if
your workstation lacks Drive A: or B:, or if you want to use a
differently formatted floppy disk as Drive A: or B:.

SlavePC supports copy-protection schemes that rely on
nonstandard floppy disk operations or formatting.

You can use SlavePC to perform any floppy disk operation. This
includes:

• Copying the contents of floppy disks to Drive C:

• Running copy-protected software directly from the PC floppy
drive
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• Writing to floppy disks from files in DEC SoftPC

How to Use SlavePC
Follow these steps to use SlavePC:

1. On the workstation, SlavePC connects to either
communications port, TTA2: or TTA3:. Make sure that
the port has read/write permissions for all users.

To determine the protection, enter:

$ SHOW DEVICE TTA2:/FULL

If the port has the correct protection, the response includes
the line:

Dev Prot S:RWLP,O:RWLP,G:RWLP,W:RWLP

If the port lacks the required protection, RWLP is missing
from G: and W:.

If the protection is incorrect, your system administrator
should change the read/write protection.

2. Connect the workstation to the PC with a SlavePC cable.
Refer to Appendix D for details on cabling. Check your
machines before making up the cable because different
connectors can be installed.

IF your workstation has a... USE a...

MMJ connector H8571-J

25-pin connector H8571-C connected to a H8571-J

3. On the PC, insert the SlavePC disk.

4. On the PC, verify that you are on Drive A: or go to Drive A:
by entering:

C:> A: Return

5. On the PC, start SlavePC from Drive A:. Enter a command
in the following format:

A:> slavepc /bbaud_rate /drive_type Return
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As you enter this command, note the following:

• Substitute the appropriate names for baud_rate and drive_
type.

• Make sure you put a b before the baud_rate.

• The baud_rate can be 19200 or the default, 9600.

IF your drive is . . . ENTER this drive_type . . .

high-density 5.25 h5

low-density 5.25 l5

high-density 3.5 h3

low-density 3.5 l3

Example: If you have a baud rate of 9600 using a high-density,
5.25-inch drive, enter the following command:

C:> a:slavepc /b9600 /h3 Return

Result: On the PC, the SlavePC menu displays:

SLAVEPC
(version 2.42)
Copyright Insignia Solutions Inc.
1989-1991
Detached from SoftPC
Press Ctrl-Break to exit

6. On the PC, remove the SlavePC floppy from the drive.
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7. On the workstation, attach SlavePC to DEC SoftPC.

a. From the Options menu, select Disk Drives, then Open
Drive.

Result: The menus are displayed.

b. Click on Replace the real floppy emulation with SlavePC.

c. Click on OK.

Disk Drives

COM/PLT Ports

Display...

Keyboard...

Memory...

Auto Flush...

Auto Freeze

Sound

FPU Emulation

Open Drive...

New Drive...

Options

Open Disk Drives

Hard Disk Drive C:  File Name...

Hard Disk Drive D:  File Name...

FSA Root Directory Name...

Floppy Drive A:  Device File Name

SlavePC Device Name

Replace the real floppy emulation with SlavePC

:

:

:

:

:

Reset CancelOK
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Floppy Drive B:  Device File Name

CD-ROM Device File Name

:

:

DISKC.HDF

TTA2:
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d. Click on OK again for the SoftPC Restart.

Open Disk Drives

Hard Disk Drive C:  File Name...

Hard Disk Drive D:  File Name...

FSA Root Directory Name...

Floppy Drive A:  Device File Name

SlavePC Device Name

Replace the real floppy emulation with SlavePC

:

:

:

:

:

Reset CancelOK
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Floppy Drive B:  Device File Name

CD-ROM Device File Name

:

:

DISKC.HDF

TTA2:

CancelOK

Warning

SoftPC Restart

This will end the current SoftPC session 
and start a new one.  Save your work
before restarting the SoftPC.

Note

Attaching or detaching SlavePC causes DEC SoftPC to
reboot.

Result: On the workstation, DOS restarts.

On the PC, the line that reads "Detached from SoftPC" changes to
"Attached to SoftPC", and the floppy light comes on.

SlavePC is ready to use.
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To stop SlavePC

1. On the workstation:

a. From the Options menu, select Disk Drives, then Open
Drive.

Result: The menus are displayed.

b. Click on Replace the real floppy emulation with SlavePC.

c. Click on OK.

d. Click on OK again for the SoftPC Restart.

Result: On the workstation, DEC SoftPC restarts.

On the PC, the message changes to "Detached from SoftPC."

2. On the PC, press Ctrl/break.

Result: On the PC, DOS restarts.

3. Disconnect the SlavePC cable between the PC and the
workstation.

When SlavePC runs, it controls the PC. You cannot use the
PC keyboard except to exit with Ctrl/Break. Limitations in the
workstation hardware and software mean that the RS-232 link
between the workstation and the PC runs at 9600 baud and
passes 512-byte blocks. Thus, SlavePC is relatively slow.
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5
Floppy Disks

This chapter describes how to use floppy disks on your
workstation. You can designate either Drive A: or Drive B:, or
both, as your floppy disk drive.

How to Use a Floppy Disk on Your Workstation
Follow these steps:

Step Action

1 Determine device name for Drive A: or B: and enter it on the
Open Disk Drives menu

2 Format the disk under VMS

3 Attach the disk to DOS

4 Format the disk under DOS

Step 1: Determine the Device Name for Drive A: or B:
Determine the device name and number for Drive A: or B: by
entering:

$ SHOW DEVICE D/FULL

The system lists all your disks. For example:

Disk DKA400: (DICKNS), device type RX26, is online,
file-oriented device, shareable, available to cluster, error logging is
enabled.

In this example, the floppy disk device type is RX26. The disk
name precedes the device type so the floppy device name is
DKA400.

To attach (activate) Drive A: or B:.

1. Put the floppy disk into the drive.
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2. From the Options menu, select Open Drive.

Result: These menus are displayed.

3. Enter the name of the floppy disk drive. For example,
DKA300:.

Click on OK.

Disk Drives

COM/PLT Ports

Display...

Keyboard...

Memory...

Auto Flush...

Auto Freeze

Sound

FPU Emulation

Open Drive...

New Drive...

Options

Open Disk Drives

Hard Disk Drive C:  File Name...

Hard Disk Drive D:  File Name...

FSA Root Directory Name...

Floppy Drive A:  Device File Name

SlavePC Device Name

Replace the real floppy emulation with SlavePC

:

:

:

:

:

Reset CancelOK
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Floppy Drive B:  Device File Name

CD-ROM Device File Name

:

:

HARD_DISK.DRIVE

SYS$LOGIN

DKA300:
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Step 2: Format the Disk Under VMS
Floppy disks must be formatted or organized before they are used.

You can format floppy disks on a real PC or on your workstation.
(Formatting floppy disks may take from 2 to 10 minutes each.)

To format a disk on a Digital workstation, enter:

$ INIT/DENSITY=DOUBLE DKA400: SHEEP
$ INIT/DENSITY=SINGLE DKA400: SHEEP
$ INIT/DENSITY=ED DKA400: SHEEP

Result: This command formats the floppy disk as a 1.44-Mbyte
device and writes a volume label SHEEP on it. The volume label
is required but not used under DOS.
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Step 3: Attach the Disk to DOS
To attach (activate) Drive A: or B:

1. Put the floppy disk into the drive.

2. From the Options menu, select Open Drive.

Result: These menus are displayed.

3. Enter the name of the floppy disk drive, for example,
DKA300:. If you do not know the floppy device name,
open a second window and follow the instructions in Step
1: Determine the Device Name for Drive A: or B:.

Click on OK.

Disk Drives

COM/PLT Ports

Display...

Keyboard...

Memory...

Auto Flush...

Auto Freeze

Sound

FPU Emulation

Open Drive...

New Drive...

Options

Open Disk Drives

Hard Disk Drive C:  File Name...

Hard Disk Drive D:  File Name...

FSA Root Directory Name...

Floppy Drive A:  Device File Name

SlavePC Device Name

Replace the real floppy emulation with SlavePC

:

:

:

:

:

Reset CancelOK
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Floppy Drive B:  Device File Name

CD-ROM Device File Name

:

:

HARD_DISK.DRIVE

SYS$LOGIN

DKA300:

5–4 Floppy Disks



Note

Drive A: can be used only by one DEC SoftPC window at
a time; DEC SoftPC attaches Drive A: to the first DEC
SoftPC window that is opened. If you are running more
than one DEC SoftPC window at a time, use the Actions
menu to change the window to which Drive A: is attached.

Step 4: Format the Disk Under DOS
Format the disk under DOS using the standard FORMAT
command.

C:> FORMAT A:

The floppy disk is now ready for use.

If you have problems, enter:

C:> HELP FORMAT

If You Forget to Remove the Floppy Disk
If you leave a VMS disk in the floppy drive when when you boot
DEC SoftPC, the result may be a black screen and a runaway
cursor. To solve this problem, open the door and restart.

DEC SoftPC bootstraps MS–DOS from the floppy drive in
preference to the hard disk, much like a real PC AT. If your drive
contains a nonbootable floppy disk, you will get an error message.
If this happens, open the drive door and press any key. This forces
DEC SoftPC to boot from the emulated hard disk.

If a DEC SoftPC Error Panel displays, stating that an invalid
instruction has been encountered, open the drive door and click
on Reset. An error panel normally appears when you boot an
incompatible floppy diskette.
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6
Printers and Modems

DOS systems have a serial (COM) port for modems, plotters,
and laptop links and a parallel (LPT) port for directly connected
printers and external disk drives.

Like a PC, DEC SoftPC provides emulation for both serial and
parallel ports. (Most DOS applications use LPT1 or COM1 ports
and do not use LPT2 and COM2 ports.) This chapter describes
how to connect printers and other communications devices to your
system and how to print DEC SoftPC files.

Print Options
You can print from DEC SoftPC in three ways:

• Using a printer directly connected to a workstation

• Using a VMS print queue

• Saving a file and then printing it
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Printing or Connecting Communications Devices

To either print or connect other communications devices, follow
these steps.

1. Physically connect the cable from your printer, modem, or
plotter to your workstation. Make sure that the serial port is
available.

2. From the Options menu, select COM/LPT Ports, then either
Printer Ports or Comm Ports.

Result: This pull-down menu, and either the Printer Ports or
Comm Ports menu, is displayed.

Disk Drives

COM/PLT Ports

Display...

Keyboard...

Memory...

Auto Flush...

Auto Freeze

Sound

FPU Emulation

Printer Ports...

Comm Ports...

Options

Reset CancelOK

Printer Ports

PrinterLPT 1:

Device Type Value Assigned

FileLPT 2:

NoneLPT 3:

MLO-009954

TTA:2

PRINTER.OUT
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3. Select the desired port.

Result: This submenu displays with the defaults shown under
Value Assigned.

Reset CancelOK

MLO-009953

Device Type Value Assigned

File

COM 1:

COM 2:

COM 3:

Pipe

Printer

COM 4: Plotter

Comms Ports

File

Pipe

Data Comm

Printer

None

TTA3:

[PRINTING]OUTPUT.FIL

TTA2:

TTA2:

4. Use the defaults by clicking on OK, or type in a different
device name, then click on OK.

Result: The default device name or your chosen device name
displays.
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Flushing the Print Buffers
The operating system stores information in its buffers. This
information must be flushed (released) if you print to a print
queue or a file. The following table provides information on the
various devices.

Device Flush Comment

VMS print
queue

Yes A large print job might fill the buffer so you
must flush more than once, causing unwanted
page breaks. To solve this problem, print to a
file, then print the file using the DOS COPY
command. Do not use the DOS PRINT utility.

Use the /B qualifier on the COPY command if
the print file contains 8-bit data used by certain
printers. Example: COPY /B print-file-name
LPT1:.

File Yes You can use the print file to mail, copy, or send
to a remote system for printing.

Directly
connected
printer

No Neither the native host system nor another
DEC SoftPC can use the printer when printing
from DEC SoftPC.

There are two ways to flush the print buffers:

IF you select . . . THEN the buffer flushes . . .

Auto Flush automatically 1 to 50 seconds after it
is loaded.

Flush ports manually and immediately. This is
useful for background printing.
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Using Auto Flush

Disk Drives

COM/PLT Ports

Display...

Keyboard...

Memory...

Auto Flush...

Auto Freeze

Sound

FPU Emulation

Options To flush the buffers automatically, follow these steps.

1. From the Options menu, select Auto Flush.

Result: These menus are displayed.

2. Place the cursor on the slide bar and move to the desired
delay time. The timing starts after the last character enters
the buffer.

Click on Enable Automatic Flushing. Click on OK.

Reset CancelOK

Auto Flush

MLO-007283

1 50

50

Auto Flush Delay Time (Seconds)

Enable Automatic Flushing
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Using Flush Ports
To flush the buffers manually:

• From the Actions menu, select Flush Ports, then the desired
port.

Result: This menu is displayed.

Flush Ports

Activate

Attach Mouse

Freeze

Restart

Actions

A Drive

C Drive

D Drive

LPT 1

LPT 2

LPT 3

COM 1

COM 2

COM 3

COM 4

MLO-007287

B Drive
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7
Changing the Graphics Option and

Increasing Memory

Your DOS applications may require various graphics options or
expanded or extended memory. DEC SoftPC provides emulated
graphic interfaces for:

• VGA or Super VGA

• EGA

• CGA

• Hercules
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Graphics Options

Disk Drives

COM/PLT Ports

Display...

Keyboard...

Memory...

Auto Flush...

Auto Freeze

Sound

FPU Emulation

Options To choose a graphics display:

1. From the Options menu, select Display.

Result: The Display menu is displayed.

2. Click on the desired display type. (Click on VGA for both VGA
and Super VGA.)

Click on OK.

Reset CancelOK
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Display Type MS-Windows

Display

VGA

EGA

CGA

Hercules

16

256

 
Colors

DEC SoftPC automatically switches from VGA to Super VGA if
your application uses Super VGA. You need do nothing.
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Expanded and Extended Memory

Disk Drives

COM/PLT Ports

Display...

Keyboard...

Memory...

Auto Flush...

Auto Freeze

Sound

FPU Emulation

Options Some DOS applications require either expanded or extended
memory. DEC SoftPC provides up to 32 Mbytes of expanded
memory and up to 16 Mbytes of extended memory. To use
expanded or extended memory:

1. From the Options menu, select Memory.

Result: The Memory menu is displayed.

2. Place your cursor on the Main Memory (extended) or
Expanded Memory slide bar and move the marker to the
desired memory size.

Click on OK.

3. If your application requires that you replace conventional
memory with expanded memory, click on the box.
(Applications rarely require this.)

Click on OK.

Result: The DEC SoftPC window restarts.

Reset CancelOK

Memory

0 32

0

Expanded Memory Size (Mbytes)

MLO-007282

1 16

4

Main Memory Size (Mbytes)

Replace the 256 - 640 Kbytes of conventional
memory with expanded memory?
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8
Sharing Files Between MS–DOS and VMS

This chapter describes how to access MS–DOS files using DEC
SoftPC’s File Sharing Architecture (FSA) which can be located on
Drives E: through Z:.

File Sharing Architecture
FSA is software that allows MS–DOS files to be stored in the VMS
file system as individual files and accessed as though they were
on an MS–DOS disk. This allows the user to:

• Access more storage than is available on a PC hard disk drive

• Copy files from system to system using the normal Network
File System (NFS) or DECnet copy commands

Sharing Files Between MS–DOS and VMS 8–1



Accessing MS–DOS Files in VMS
You access a directory in VMS by naming the FSA Root Directory.

1. From the Options menu, select Disk Drives, then Open Drive.

Result: These menus are displayed.

2. Enter the FSA root directory name.

3. Click on OK.

Disk Drives

COM/PLT Ports

Display...

Keyboard...

Memory...

Auto Flush...

Auto Freeze

Sound

FPU Emulation

Open Drive...

New Drive...

Options

Open Disk Drives

Hard Disk Drive C:  File Name...

Hard Disk Drive D:  File Name...

FSA Root Directory Name...

Floppy Drive A:  Device File Name

SlavePC Device Name

Replace the real floppy emulation with SlavePC

:

:

:

:

:

Reset CancelOK
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Floppy Drive B:  Device File Name

CD-ROM Device File Name

:

:

C.DOS

D.DOS

DKA100:[PCAPPS]

DKA400:
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Networked Drive Restrictions
An FSA drive has the same restrictions in the operations it
supports as does an MS–DOS networked drive. MS–DOS
commands such as DISKCOPY or SYS do not work because
they operate on low-level disk hardware that does not exist on a
networked drive.

Generally, commands marked with the ‘‘Network Not Allowed’’
symbol in the MS–DOS User’s Manual do not work on an FSA
drive.

You cannot install copy-protected programs onto an FSA drive
because most copy-protection schemes attempt to program the
disk hardware at a low level. To install copy-protected software,
use one of the hard disk drives, C: or D:.

To share files between programs running under MS–DOS and
VMS processes, or between multiple systems across a network,
the files should reside on network drives. Hard disks can also
be shared across a network, but you must be aware of possible
conflicts with simultaneous access.

Be sure you understand the implications of sharing Drives
E: through Z:. Storing files on these drives imposes a large
overhead on DEC SoftPC. You may experience a noticeable delay
when opening files or doing a directory. Executing a directory
command, for example, requires accessing each remote file. Since
performance is dependent on the number of files in each directory,
it is advisable to keep directories small.

Sharing Data
If an application running under VMS uses an identical file format
when it runs under MS–DOS, you can share data between the two
implementations of the application. You cannot, however, share
data if the storage methods differ. Although Drives E: through
Z: access the VMS file system, the operating system may use a
different file format than does MS–DOS.
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Converting File Formats in VMS
Two commands allow you to convert text files between MS–DOS
and VMS.

To copy an MS–DOS file to a VMS format text file, use:

$ SOFTPC/DOS_TO_VMS DOSFILE.DAT VMSFILE.DAT

To copy a VMS file to an MS–DOS file, enter:

$ SOFTPC/VMS_TO_DOS VMSFILE.DAT DOSFILE.DAT

Drives E: through Z: Naming Conventions
You can use the same file names in MS–DOS and in VMS if you
follow MS–DOS conventions. However, DEC SoftPC treats VMS
file names that do not fit MS–DOS conventions in the following
way:

• VMS file names with more than eight characters are truncated
to eight characters and the filetype changes. Thus, the
VMS file name LONG$NAME.LIS appears in MS–DOS as
LONG$NAM.HM^.

• VMS filetypes longer than three characters are replaced
by a specially encoded form. Thus, the VMS file name
FILENAME.LONG appears in MS–DOS as FILENAME.@Y7.

• If multiple versions of a VMS file exist, only the file with the
highest version number appears under MS–DOS.

Invalid MS–DOS File Names
Some file names are not valid under VMS. These are treated as
follows:

• MS–DOS file names that contain characters considered
illegal under VMS are replaced by a specially encoded
form. Thus, the MS–DOS file name {WP}.TMP becomes
SOFTPC$7B57507D2E544D50 under VMS.

• MS–DOS filetypes that include characters considered
illegal under VMS are replaced by a specially encoded
form. Thus, the MS–DOS file name NAME.%%% becomes
SOFTPC$4E414D452E252525 under VMS.

8–4 Sharing Files Between MS–DOS and VMS



9
Using DEC SoftPC on a VT220 or

Equivalent Terminal

This chapter describes how to configure a VT220 or equivalent
terminal to run DEC SoftPC and how to use DEC SoftPC on that
terminal. The chapter has four sections:

• Essential files and restrictions

• Using DEC SoftPC on a terminal

• Editing DEC SoftPC’s configuration file

• Configuring the terminal

Essential Files and Restrictions

Essential Files
The VMS installation procedure automatically copies the essential
files into the file, SOFTPC$SYSTEM:.

Restrictions
The following restrictions exist when you use DEC SoftPC on a
terminal:

• The terminal must be a VT220 or compatible with a VT220.

• You can run only Monochrome Display Adaptor (MDA)
applications. You cannot run CGA, EGA, VGA, or Hercules
applications.

• You cannot use a mouse.

• You cannot freeze DEC SoftPC.
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Using DEC SoftPC on a Terminal
To start DEC SoftPC on a VT220 terminal, enter:

$ SoftPC /INTERFACE=CHARACTER_CELL Return

Result: SoftPC comes up in character cell (also called serial
terminal) mode.

Specifying "/KEY_DEFINITIONS=keymap-file" forces DEC SoftPC
to use a keymap file other than the default file for the VT220
terminal. The default is DEC SoftPC$SYSTEM:TERM.KEY for
Serial Terminal mode.

The first time DEC SoftPC starts, you are asked if you want to
accept the system defaults or quit. Choose the defaults (which
include the configuration file) and the MS–DOS prompt (C:\>)
appears. You can now use MS–DOS or run DOS applications.

To quit, press the key sequence F8, Ctrl[, and 0.

To change the configuration file, see Editing DEC SoftPC’s
Configuration File later in this chapter.

Using the VT220 Terminal Keyboard
Figure 9–1 shows the VT220 terminal keyboard with some keys
mapped. Appendix F has additional information about key
mapping.
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Figure 9–1 VT220 Terminal Keyboard
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Escape

Delete

The table below shows the equivalent DOS and VT function keys.

DOS VT

F1 F11

F2 F12

F3 F13

F4 F14

F5 F17

F6 F18

F7 F19

F8 F20

F9 F9

F10 F10
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Toggle

When you start a DEC SoftPC session, the keys have Digital
key assignments. You activate DEC SoftPC key assignments by
pressing Toggle. This key toggles the keyboard between DEC
SoftPC mode and Digital mode.

ROCK

A PC uses 25 lines while most terminals use 24 lines. You use the
Rock key to toggle the 25th line on and off the screen display or
C:\INSIGNIA\ROCKSCR.COM for batch jobs.

HOLD

Some software applications require an auto-repeat function which
is generated when a key is held down. You emulate this by
simultaneously pressing HOLD and the key that is to auto-repeat.
If the key is a character key, the character repeats on your screen.
If you press HOLD again, this function is cancelled.

Key Sequences in VT220 Mode
Use the following key sequences:

1. Toggle (if you are in Digital mode).

2. Press Ctrl/[.

3. Press Escape and the appropriate main keyboard key shown
in the following table:

For this action... Press this key...

To attach or detach a floppy disk on Drive A: 3

To attach or detach a floppy disk on Drive B: 4

To attach or detach a floppy disk on SlavePC 5

To attach or detach a currently active port 6

To flush the communications ports ( print ) 1

To refresh the screen 2

To exit DEC SoftPC 0
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The following actions do not require the Toggle and Ctrl/[
sequence:

For this action... Press...

To display settings for drives and ports Help

To invoke a text editor ( vi ) for the configuration
file

DO

To reset DEC SoftPC Ctrl/Alt/Del1

1These keys are Find and Select on the arrow keypad and period on the numeric
keypad.

Using .COM Commands

• FLATOG.COM allows you to toggle the floppy disk port for
Drive A: on or off; FLABOG.COM allows you to toggle the
floppy disk port for Drive B: on or off.

• TOGCOM.COM allows you to toggle communications ports on
or off.

Example: TOGCOM

Editing DEC SoftPC’s Configuration File
The configuration file is set up automatically the first time you
use DEC SoftPC in terminal mode. It is created in the directory
in which you started DEC SoftPC and called SPCCONFIG.INI.
You can use the default configuration file or you can edit the file
to fit your needs.

A configuration file on a terminal allows you to select hard disks,
to attach flexible disk drives, and to perform other DEC SoftPC
functions.

The configuration file sets up your terminal for DEC SoftPC
each time you start a session. To edit the configuration file,
use a text editor such as EDIT/EDT. Changes you make in the
configuration file take effect the next time you start DEC SoftPC.
Be sure to save your edits. A sample configuration file is shown in
Chapter 10.
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Attaching Drive A: and B:
If a floppy disk drive is connected when you start a DEC SoftPC
session, you must specify if DEC SoftPC should use Drive A: or B:.
See Key Sequences in VT220 Mode earlier in this chapter.

Setting Up Devices
Edit the line in the configuration file for COM type and COM port.
The lines for type and port must correspond. For type, use one of
the following: File, Datacomm, Printer, Plotter, Pipe, or None.

In the SoftPC file, the corresponding entries could be:

COM_PORT_1_TYPE Datacomm
COM_PORT_1 TTA2:

Display Type
You cannot change the display type. It defaults to Monochrome
Display Adapter (MDA). The DISPLAY_GRAPHICS_ADAPTER
parameter in the configuration file sets the display type, but DEC
SoftPC ignores the line when running on a serial terminal.

Setting Up Memory
You can increment the MEMORY_EXPANDED_SIZE parameter
up to 32 Mbytes and the MEMORY_EXTENDED_SIZE up to
16 Mbytes.

To set the conventional 640-Kbyte memory for MS–DOS, verify
that the SPCCONFIG.INI file reads as follows:

MEMORY_EXPANDED_BACK_FILL NO
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Setting Drive Names
Edit the following parameters to set the appropriate drive file
names.

For example:

DRIVE_CDROM_DEVICE_NAME
DRIVE_FLOPPY_A_DEVICE_NAME DKA100:
DRIVE_FLOPPY_B_DEVICE_NAME
DRIVE_C_FILE_NAME DKB100:[DOS]C.DRIVE.HDF
DIRVE_D_FILE_NAME DKB100:[APPS]D_DRIVE.HDF
DRIVE_FSA_ROOT_DIRECTORY SYS$LOGIN

where Drive C: is named C_DRIVE.HDF; Drive D: is named
D_DRIVE.HDF; and Drive E: is named SYS$LOGIN.

Creating an Empty Hard Disk
To create an empty hard disk file for a VT220 or equivalent
terminal, use the SOFTPC/HARD_DISK_CREATE command.

$ SOFTPC/HARD_DISK_CREATE new-disk-name size

where new-disk-name is the file name of the container file to be
created and size is the number of Mbytes in the container file (1
to 300).

Edit the line DRIVE_D_FILE_NAME, in the SoftPC configuration
file to select the new container file as Drive D:.

Finally, start up SoftPC and prepare the new hard disk file for
SoftPC as described in Chapter 3.

Configuring the Terminal

System Administrator Tasks
The system administrator should do the following tasks:

1. Connect the terminal using the RS232 interface. Follow the
instructions in your terminal’s user’s guide.

2. Determine your terminal name by entering:

$ SHOW DEVICE TT

The system responds with a list. Usually a VAXstation is
TTA2: or TTA3:.
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User Tasks
Use the cursor keys to move to the Keypad option. Use Enter to
toggle between the Application and Numeric settings.

After you set the keypad to Application, change the communica-
tion settings to match the following table:

Baud
Rate Parity

Data
Bits

Stop
Bits

Xon
Xoff Term Mode

9600 None 8 1 Enabled VT200 7 Bit

Next, move the cursor to Save and press Enter. These settings are
used each time you start DEC SoftPC.

If you have problems:

1. Verify that the connections are secure.

2. Check that the terminal’s communications settings are correct.

3. Make sure that the keys are not sticking, dirty, or broken.

4. Verify that the device has the correct permissions.

Your terminal should now be configured and ready to use.
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10
Helpful Hints

This chapter includes hints on using DEC SoftPC and answers to
frequently asked questions.

How can I increase performance?
To increase the performance of DEC SoftPC, carefully read the
documentation that comes with your application software. Any
information on optimizing your application applies equally to
optimizing that application’s performance on DEC SoftPC.

How can I increase the speed of Windows?
You can increase the speed of Windows by at least 200 percent if
you install the native-mode drivers which DEC SoftPC provides.

1. Remove any previous installation of Windows. (You cannot use
the drivers if you do an upgrade installation.)

2. Place the Microsoft Windows disk #1 into Drive A:.

3. At the A:> prompt, enter

SETUP Enter .

4. From the menu, select complete installation.

5. In the Windows Setup screen, select Display.

6. Move the cursor to the end of the option list and select
Other. (This option requires a disk provided by a hardware
manufacturer such as Insignia.)

7. Enter

C:\INSIGNIA.

Only one item will be on the list, DEC SoftPC Display.

8. Press Enter .
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9. Select Mouse.

10. Move to the end of the option list and select Other. (This
option requires a disk provided by a hardware manufacturer.)

11. Enter

C:\INSIGNIA.

Only one item will be on the list, DEC SoftPC Mouse.

12. Press Enter .

13. At the Main Menu, press Enter .

Now continue your normal Windows installation procedure.

Why am I getting font errors?
You might get font errors if you did not reboot the system after
the installation.

The installation procedure copies the SoftPC fonts to the
DECwindows font directories, but the DECwindows server
does not recognize the DEC SoftPC fonts until the server is
restarted.

How can I use a client-server configuration?
You must load Motif and the correct Motif license on the client.

How can I run SlavePC?
Some PCs are incompatible with SlavePC. The following PCs, plus
those that are 100% compatible with these listed PCs, work with
SlavePC:

• IBM PC

• IBM PC/AT

• IBM PS/2 model 30

• COMPAQ

• Vectra

• DECstation
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How do I edit the configuration file?
The configuration file, SPCCONFIG.INI, is created the first time
you start DEC SoftPC. This file (also called the initialization file)
stores your changes when using the DEC SoftPC menus. The
current version of the file is read each time a SoftPC window is
started. If the contents of the file are incorrect or inconsistent,
error messages appear.

Normally, you should not edit SPCCONFIG.INI. You may need to,
however, if errors occur. Be careful to change only the values on
the right; do not change the names on the left.

This is a sample configuration file. Callouts explain each line.

1 MEMORY_EXTENDED_SIZE 4

1 MEMORY_EXPANDED_SIZE 0

2 MEMORY_EXPANDED_BACK_FILL No

3 DRIVE_CD–ROM_DEVICE_NAME

4 FPU_EMULATION No

5 DRIVE_C_FILE_NAME SOFTPC$SYSTEM:3MB.HDF

6 DRIVE_FSA_ROOT_DIRECTORY SYS$LOGIN

6 DRIVE_FLOPPY_A_DEVICE_NAME

6 DRIVE_FLOPPY_B_DEVICE_NAME

6 DRIVE_SLAVEPC_DEVICE_NAME

7 DISPLAY_GRAPHICS_ADAPTER VGA

8 DISPLAY_SIZE 1.5

9 DISPLAY_MSWIN_WIDTH 884

1 0 DISPLAY_MSWIN_HEIGHT 490

1 1 DISPLAY_MSWIN_COLORS 16

1 2 LPT_PORT_1_TYPE File

1 2 LPT_PORT_2_TYPE

1 2 LPT_PORT_2_TYPE

1 2 LPT_PORT_1

1 2 LPT_PORT_2

1 2 LPT_PORT_2

1 2 COM_PORT_1_TYPE
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1 2 COM_PORT_2_TYPE

1 2 COM_PORT_3_TYPE

1 2 COM_PORT_4_TYPE

1 2 COM_PORT_1

1 2 COM_PORT_2

1 2 COM_PORT_3

1 2 COM_PORT_4

1 3 SOUND Yes

1 3 AUTO_FREEZE No

1 3 AUTO_FLUSH No

1 4 AUTO_FLUSH_DELAY 50

1 5 KEYBOARD_MAP_FILE_NAME SOFTPC$SYSTEM:XKBDMAP.KEY

1 This selects expanded memory size, depending on your
available memory.

2 Indicates that a portion of the 640–MByte base memory is to
be replaced by expanded memory.

3 Points to the CD–ROM device name.

4 Indicates whether DEC SoftPC is emulating floating-point
hardware.

5 This is the pointer to your system disk (C: drive) using the
standard file format.

6 This is a pointer to a specific directory.

7 Enter CGA, VGA, Hercules, or EGA, depending on your
application’s requirements.

8 This is your DEC SoftPC window size: 1, 1.5, or 2.

9 This is your Windows width.

1 0 This is your Windows height.

1 1 This is the number of colors used with Windows.

1 2 These are the actual defaults for each communications (COM)
or printer (LPT) port. For additional information, see the
following table.

1 3 Indicates whether this function is on (yes) or off (no).

1 4 Indicates the delay in seconds between flushes.
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1 5 Indicates the name of the xkeyboard map.

COM Type and COM Port Entries
The line for COM type and COM port must correspond when you
edit the configuration file, as shown in the following table:

If printing directly to a printer You enter

LPT_PORT_1_TYPE printer name
LPT_PORT_1 TTA2:

If printing to a file You enter

LPT_PORT_1_TYPE standard VMS file name
LPT_PORT_1 standard VMS file name

If printing to a system print queue You enter

LPT_PORT_1_TYPE print queue name
LPT_PORT_1 system printer name
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A
VMS Installation

This appendix describes how to install DEC SoftPC on the VMS
operating system. File protection for the VMS operating system is
discussed in Appendix E.

Definitions: Real floppy and SlavePC

A real floppy is a floppy disk on your Digital workstation.
In contrast, SlavePC is software that allows you to use a
floppy disk on a real PC connected to your Digital system
via a serial communications line. Either configuration
allows you to load and unload software.

Note

During the installation you are asked if you wish to use
a real floppy device and you are asked for the name of
this device. You need this device name before starting
installation. To find the name, enter:

$SHO DEV D Return

You are also asked about SlavePC. Then you are asked
to specify which communications port is being used to
connect to the real PC. You need this communications port
name before starting the installation (it will be either
TTA2 or TTA3). To find out the communications port,
consult the user’s manual for your system.
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Preparing to Install SoftPC Under VMS
Your bills of material (BOM) and indented bills report (BIL)
specify the number and contents of your media. Be sure to check
the contents of your kit against this information. If your kit is
damaged or if you find that parts of it are missing, call your
Digital sales representative.

Distribution media must be mounted in numerical order. The
installation procedure prompts you to mount the volumes. For
more information on how to mount distribution media, see your
processor-specific installation/operations guide, which also details
several options to the installation procedure.

Accessing the Online Release Notes
SoftPC provides online release notes. The prompt to display or
print the release notes during the installation appears in step 5 of
the installation procedure when you invoke VMSINSTAL with the
OPTIONS N parameter.

To obtain the release notes after the installation, type or print
the file SYS$HELP:SOFTPC040.RELEASE_NOTES. After the
installation, type the following command:

$ TYPE SYS$HELP:SOFTPC040.RELEASE_NOTES Return

Installation Procedure Requirements
The installation takes 10 to 20 minutes, depending on the type of
media and your system configuration. Before installing SoftPC,
you must have the following privileges and resources:

• VMS operating system, Version 5.5.

• SETPRV privileges, or CMKRNL, WORLD, and SYSPRV
privileges.

• A minimum of 20,000 blocks of free disk space during
installation; approximately 20,000 blocks after installation.

• An additional 21,000 blocks for each 10-Mbyte increment of
hard disk that you configure.
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• A minimum of 10 free global sections at installation.

Note

You must ensure that your system has the necessary
global page and global section SYSGEN quotas for the
installation. Failure to do so could corrupt the DCL tables.

To determine the number of available global pages on your system,
invoke the VMS Install Utility:

$ INSTALL :== $INSTALL/COMMAND_MODE Return

$ INSTALL Return

Then enter the following command:

INSTALL> LIST/GLOBAL/SUMMARY Return

Summary of Local Memory Global Sections

189 Global Sections Used, 11964/18036 Global Pages Used/Unused

INSTALL> EXIT Return

The system displays a summary of the number of global sections
used. Write down the number of global sections used. To exit from
the VMS Install Utility, type EXIT.

To determine the number of available global sections, invoke
SYSGEN:

$ RUN SYS$SYSTEM:SYSGEN Return

SYSGEN>SHOW GBLSECTIONS Return

SYSGEN>EXIT Return

The number displayed under Current Used is the number of
global sections in use. Compare this number to the number of
global sections in use displayed by the VMS Install Utility.

SoftPC requires 10 global sections.

Therefore, if the number of global sections used plus 10 exceeds
the maximum number of global sections, you must increase the
number of available global sections before you can install SoftPC.
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To increase the number:

1. Use SYSGEN to increase the GBLSECTIONS system
parameter.

2. Edit the file SYS$SYSTEM:MODPARAMS.DAT.

3. Invoke the SYS$UPDATE:AUTOGEN.COM procedure.

For more information on the AUTOGEN.COM procedure, see your
processor-specific installation/operations guide.

User Account Quotas and Privileges
To use SoftPC, each account must have TMPMBX and NETMBX
privileges and the following requirements:

• Working set quota (WSquo) 2048 (minimum)

• Working set extent (WSextent) 4096 (minimum)

• Paging file quota (Pgflquota) 70,000 pages (minimum)

• Working set size (WSdef) 1,200 pages (minimum)

Use the VMS Authorize Utility (AUTHORIZE) to compare the
current values of these quotas with the requirements for SoftPC.
For example, the account used below is the SYSTEM account:

$ SET DEFAULT SYS$SYSTEM Return

$ RUN AUTHORIZE Return

UAF> SHOW SYSTEM Return

The following example shows how to change the values of these
quotas:

$ SET DEFAULT SYS$SYSTEM Return

$ RUN AUTHORIZE Return

UAF> MODIFY SYSTEM/WSQUO= 2048 Return

UAF> MODIFY SYSTEM/WSEXTENT=4096 Return

UAF> MODIFY SYSTEM/PGFLQUOTA=70,000 Return

UAF> MODIFY SYSTEM/WSDEF=1200 Return

VMS License Management Facility
The VMS License Management Facility (LMF) is available with
Version 5.5 of the VMS operating system. If you are installing
SoftPC on a VMS system, you must register your SoftPC software
license.
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The license registration information you need is contained in the
Product Authorization Key (PAK) shipped with SoftPC. The PAK
is a paper certificate that contains information about your license
to run a particular piece of software.

During the installation, you are asked if you have registered the
SoftPC license and loaded the appropriate authorization key. You
must register and load your license for SoftPC before you start the
installation in order to use the software.

To register a license under VMS, first log in to the system
manager’s account, SYSTEM. You then have a choice of two ways
to perform the registration:

• Invoke the SYS$UPDATE:VMSLICENSE.COM procedure.
When it prompts you for information, respond with data from
your Product Authorization Key (PAK).

• Issue the LICENSE REGISTER DCL command with the
appropriate qualifiers that correspond to information on the
PAK.

For complete information on using LMF, see the manual on the
License Management Utility in the VMS documentation set.

Using VMSINSTAL
You can log in to the system account to install SoftPC; invoke
VMSINSTAL, the command procedure that installs this product.
An example of this procedure is shown in steps 1 and 2 of the
Installing SoftPC section later in this appendix.

The VMSINSTAL command procedure has the following syntax:

$ @SYS$UPDATE:VMSINSTAL SOFTPC ddcu: [OPTIONS N]

ddcu:
Represents a device name where the distribution volumes will be
mounted for the SoftPC installation media, where dd is the device
code, c is the controller code, and n is the unit number. It is not
necessary to use the console drive to install SoftPC. However,
if you do use the console drive, you should replace any media
you removed from the drive. MUA0: is the device name used in
examples in this document.
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OPTIONS N
Is an optional parameter you should provide if you want to be
prompted to display or print the release notes. If you do not
include the OPTIONS N parameter, VMSINSTAL does not prompt
you to display or print the release notes. VMSINSTAL permits
the use of several other options. For more information on the
other options, see your processor-specific installation/operations
guide.

If you do not supply the first two parameters, VMSINSTAL
prompts you for the product and device names. If you wish to be
prompted for the product and device names and to display or print
the release notes, enter the following:

$ @SYS$UPDATE:VMSINSTAL Return

When you invoke VMSINSTAL, it checks the following:

• Whether you are logged in to a privileged account. Digital
recommends that you install software from the system
manager’s account with your default device and directory set
to SYS$UPDATE.

• Whether you have adequate quotas for installation.
VMSINSTAL checks for the following quota values:

ASTLM = 24

BIOLM = 18

BYTLM = 18,000

DIOLM = 18

ENQLM = 30

FILLM = 20

VMSINSTAL then checks whether the following conditions exist:

• DECnet is up and running

• Any users are logged in to the system

If VMSINSTAL detects either of these conditions, you are asked
whether you want to continue the installation. If you want to
continue, type YES. If you want to stop the installation, press
Return. If you stop, you must discontinue the conditions before
resuming the installation procedure.
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Installing SoftPC
This section contains excerpts from the installation procedure and
explains each step. Defaults appear in brackets throughout the
installation procedure.

To abort the installation procedure at any time, press Ctrl/Y.
When you press Ctrl/Y, the installation procedure deletes all files
it has created up to that point and then returns you to DCL level.
If you want to retry the installation procedure after pressing
Ctrl/Y, you must proceed from step 2.

Step 1: Log in to the system account and set your default
device and directory to SYS$UPDATE.

Return

Username: SYSTEM Return

Password: Return

$ SET DEFAULT SYS$UPDATE Return

Step 2: Invoke VMSINSTAL.
$ @VMSINSTAL SOFTPC040 MUA0: OPTIONS N Return

VAX/VMS Software Product Installation Procedure VX.X

It is dd-mmm-yyyy at hh:mm.
Enter a question mark (?) at any time for help.

* Are you satisfied with the backup of your system disk
[YES]? Return

If you are satisfied with the backup of your system disk, press
Return. Otherwise, type N and press Return to discontinue the
installation.

Step 3: Insert the first installation kit volume.
Please mount the first volume of the set on MUA0:.
* Are you ready? YES Return

The following products will be processed:

SOFTPC V4.0

Beginning installation of SOFTPC V4.0 at hh:mm

%VMSINSTAL-I-RESTORE, Restoring product saveset A...

To indicate that you want to continue the installation, mount
volume 1, type YES, and press Return.
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Step 4: Select a release notes option.
This step applies only if you specified OPTIONS N in step 2.

Release Notes Options:

1. Display release notes
2. Print release notes
3. Both 1 and 2
4. Copy release notes to SYS$HELP
5. Do not display, print or copy release notes

* Select option [3]: Return

If you select option 1, VMSINSTAL displays the release notes on
line immediately. You can terminate the display at any time by
pressing Ctrl/C.

If you select option 2, VMSINSTAL prompts you for a queue name.
Either type a queue name or press Return to send the file to the
default output print device.

* Queue name [SYS$PRINT]: Return

If you select option 3, VMSINSTAL displays the release notes on
line immediately. You can terminate the display at any time by
pressing Ctrl/C. VMSINSTAL then prompts you for a queue name.
Either type a queue name or press Return to send the file to the
default output print device. The SoftPC release notes are then
copied to SYS$HELP:SOFTPC040.RELEASE_NOTES.

If you select option 4, VMSINSTAL copies the release notes to
SYS$HELP immediately.

If you select option 5, VMSINSTAL does not display, print, or
copy the release notes; typically this option is selected when the
user wants to terminate the installation. If you select release note
option 5, which specifies that the release notes are not copied to
SYS$HELP, you cannot access the release notes without installing
the product kit again.

Note

This version of the release notes file installed by
VMSINSTAL is labeled with the current product name
and version number. Take care not to delete release notes
for previous versions of SoftPC.
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Next, VMSINSTAL displays the following prompt:

* Do you want to continue the installation [N]?: Y Return

%VMSINSTAL-I-RELMOVED, The product release notes have been successfully
moved to SYS$HELP.

If you want to continue the installation, type YES and
press Return. If you type NO or press Return, VMSINSTAL
discontinues the installation. In either case, VMSINSTAL moves
the release notes to SYS$HELP.

Step 5: Select installation options.
* Do you want to purge files replaced by this installation
[YES]? Return

The directories SYS$COMMON:[SOFTPC], SYS$HELP,
SYS$LIBRARY, SYS$MANAGER, and SYS$SYSTEM may
contain previous versions of SoftPC files. These files are replaced
during the installation with new files, but the old files are not
automatically purged. Purging is recommended. In response to
the purging prompt, press Return to purge the files or type NO to
keep them.

* Do you want to run the IVP after the installation
[YES]? Return

The Installation Verification Procedure (IVP) runs tests to check
whether the installation procedure was successful. Press Return
to run the IVP after the installation. If you do not want to run the
IVP, type NO in response to the prompt.

Step 6: Respond to license registration queries.
SoftPC supports the VMS LMF. The installation procedure
displays license information about your product and then asks
if you have registered and loaded your authorization key for
SoftPC. The following is an example of such information:

Product: SOFTPC
Producer: DEC
Version: 4.0
Release Date: dd-mmm-yyyy

* Does this product have an authorization key registered and loaded?

If you have not registered and loaded your authorization key, you
must answer NO to this question. You have to register and load
your PAK to successfully complete the installation.

During the installation procedure, the SoftPC LMF key is invoked.
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Step 7: Read informational messages.
The SoftPC installation procedure produces a number of
informational messages that report on the progress of the
installation.

If the installation procedure is successful, the new or modified
files are moved to their target directories.

SYS$HELP:HELPLIB.HLB and SYS$LIBRARY:DCLTABLES.EXE
files are updated to include the new versions of the SOFTPC
HELP text.

If you typed YES in response to the prompt that requests a file
purge at step 5, previous versions of the SoftPC files are now
purged.

Step 8: Observe the installation verification procedure.
If you chose to run the IVP in step 5, VMSINSTAL now calls the
IVP to verify that SoftPC was installed successfully.

Step 9: End the installation procedure.
Installation of SoftPC V4.0 completed at 11:22
SoftPC IVP completed with 0 errors
VMSINSTAL procedure done at 11:35

Quit your session.

When the product installation procedure is complete, you can
choose to install more products or to log out. If you removed any
media from the console drive before beginning the installation,
you should replace it now.

System Manager’s Notes
You must perform the following steps:

Step 1: Add the SoftPC startup procedure.
The installation procedure must add a SoftPC startup procedure
to the SYS$STARTUP directory. This file sets up system-wide
information for SoftPC such as the location of your floppy device.
It must be executed by SYSTEM when VMS starts up. Add:

@SYS$STARTUP:SOFTPC$STARTUP.COM

to

SYS$COMMON:[SYSMGR]SYSTARTUP_V5.COM
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and delete it from:

SYS$COMMON:[SYSMGR]SYSLOGIN.COM

Step 2: Set up possible devices for your floppy and SlavePC.
SOFTPC$STARTUP.COM sets up _NL: default assignments for
the SOFTPC$FLOPPY and SOFTPC$SLAVEPC device names. If
you wish to use a real diskette drive or a SlavePC diskette drive
with SoftPC, edit the SOFTPC$FLOPPY and SOFTPC$SLAVEPC
logical names with the appropriate device name.

SoftPC Fonts
The installation procedure copies the SoftPC fonts to the
DECwindows font directories; however, the DECwindows server
does not recognize the SoftPC fonts until it reloads the fonts when
you reboot the system.

To display the SoftPC output on a remote X system, you must the
copy the fonts to that system and make them known to the remote
Xserver.

SoftPC Help Text
Help text for the SOFTPC command is released with SoftPC and
added to the DCL help library.

SoftPC Floppy Configuration File
SoftPC reads the configuration file
SOFTPC$SYSTEM:RFLOPPY.DAT to determine the mapping
between VMS device type numbers and PC drive types. The file
includes comments describing the required data format so the
knowledgeable system manager can change the configuration.

Step 3: You must restart the windows server when the
installation is complete. Otherwise, the SoftPC fonts are not
known to the system.
To do this, enter:

$ SET DEF SYS$MANAGER Return

$ @DECW$STARTUP RESTART Return
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Installing SoftPC on a VAXcluster
If you want to run SoftPC on multiple nodes of a VAXcluster, first
check to see that you have the appropriate software license. Then,
follow these steps after installing SoftPC:

1. Issue the LICENSE LOAD command to activate the license
on each node in the VAXcluster on which SoftPC is to be
executed.

2. Run SYS$STARTUP:SOFTPC$STARTUP.COM on each node
of the cluster that has a software license.

3. To use the product on other nodes in the VAXcluster, you must
replace the version of the DCL tables that is installed on the
other VAXcluster nodes. To do this, perform the following
steps:

a. Log in to a node on the cluster.

b. Run INSTALL and enter the following command at the
INSTALL> prompt:

INSTALL> REPLACE SYS$LIBRARY:DCLTABLES.EXE Return

4. Repeat steps a and b for each node of the cluster.

Installing the SoftPC License
Any existing SoftPC license must be disabled before the new
SoftPC license and SoftPC software can be installed. To do this,
enter the following command:

$> LICENSE LIST SOFTPC/FULL Return

A list of existing SoftPC licenses is displayed. For each existing
license, copy the string following "Authorization" in the display,
then disable the license by entering the following commands
(replacing xx with the authorization code):

$> LICENSE UNLOAD SOFTPC Return

$> LICENSE DISABLE SOFTPC/AUTH=xx Return

Repeat the commands for each enabled license listed in the
database. Once this is done, the new license can be registered
(refer to the installation instructions for SoftPC). The new license
must be loaded before SoftPC is installed by issuing the following
command:
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$> LICENSE LOAD SOFTPC Return

Setting File Protections
The files in SYS$COMMON:[SOFTPC] are set to "world" read
and execute when SoftPC is installed. The 3MB.HDF file can be
set to "world" read, write, and execute protection by issuing the
following command from the SYSTEM account:

$> SET PROTECTION=W:RWE SYS$COMMON:[SOFTPC]3MB.HDF Return

As an alternative, the file can be copied into each SoftPC user’s
directory.

SoftPC is now installed and can be invoked by all users with the
SoftPC command.

The installation procedure modifies the DCL command table so
that the SoftPC command is recognized and processed. However,
the previous command table is still in effect for those users who
are currently logged in. All logged-in users who want to use the
SoftPC command must log out of the system and log in again.

Running the Installation Verification Procedure Separately
The Installation Verification Procedure (IVP) is usually run at
installation. If you want to run the IVP separately to ensure the
integrity of installed files if system problems occur, execute the
following command:

$ @SYS$TEST:SOFTPC$IVP.COM Return

If the IVP fails for any reason, the failed files are marked. (The
IVP may fail if you modified the 3MB.HDF after installation. This
is not a bug.)

If the installation fails, you must restart the installation procedure
from step 2. If the installation fails due to an IVP failure, contact
your Digital Services representative.

Maintenance Updates
Digital may periodically issue maintenance updates of SoftPC.
Each update consists of an installation kit. You should install
this kit as described in this document or in any document that
accompanies the maintenance update.
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Each time a maintenance update is released, the version number
changes. For example, if the current version is 1.0, the version
number of the first maintenance update will be 1.1. In addition,
each maintenance update includes new release notes. The release
notes describe the changes that have been made to SoftPC since
the previous release.

The update release notes are provided on line. You should
read the release notes when you first install SoftPC; they are
also accessible at any time after the product is installed. For
information on reading the release notes when you install SoftPC,
follow the installation procedure through step 5. To locate the
release notes after SoftPC is installed, display or print the file
SYS$HELP:SOFTPC040.RELEASE_NOTES.

Determining and Reporting Problems
If an error occurs while you are using SoftPC and you believe
that the error is caused by a problem with SoftPC, do one of the
following:

• If you purchased SoftPC within the past 90 days and you
think the problem is caused by a software error, submit a
Software Performance Report (SPR).

• If you have a Basic or DECsupport Software Agreement,
call your Customer Support Center. With these services, you
receive telephone support that provides high-level advisory
and remedial assistance. For more information, contact your
local Digital representative.

• If you have a Self-Maintenance Software Agreement, submit
an SPR.

If you find an error in the SoftPC documentation, fill out and
submit a Reader’s Comments form from the back of the document
in which the error was found. Include the section and page
number where the error was found.
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Sample Installation
This section contains a sample installation of SoftPC. Note that
this is only a sample. Sometimes the installation procedure is
modified in maintenance updates of this product.

Welcome to VAX/VMS V5.5-2

Username: SYSTEM
Password:
Welcome to VAX/VMS version V5.5-2 on node F350

Last interactive login on Monday, 3-MAY-1993 08:32
Last non-interactive login on Monday, 3-MAY-1993 08:33

$ @sys$update:vmsinstal
VAX/VMS Software Product Installation Procedure V5.5-2

It is 7-MAY-1993 at 09:39.

Enter a question mark (?) at any time for help.
* Are you satisfied with the backup of your system disk [YES]?
* Where will the distribution volumes be mounted: DKB300:[SOFTPCBUILD.VAXFINAL]

Enter the products to be processed from the first distribution volume set.

* Products: *
* Enter installation options you wish to use (none):

The following products will be processed:

SOFTPC V4.0

Beginning installation of SOFTPC V4.0 at 09:40

%VMSINSTAL-I-RESTORE, Restoring product save set A ...
%VMSINSTAL-I-RELMOVED, Product’s release notes have been moved to SYS$HELP.
* Do you want to purge files replaced by this installation [YES]?
* Do you want to run the IVP after the installation [YES]?

SoftPC 4.0 requires VMS 5.5 & later and if you are running on
a workstation - then you need MOTIF 1.1 & later

%SOFTPC-I-COMMENCE, SoftPC V4.0 installation is commencing ...
%SOFTPC-I-CHECKVMS, Checking for VMS version 5.5 or greater ...

Product: SOFTPC
Producer: DEC
Version: 4.0
Release Date: 26-APR-1993

* Does this product have an authorization key registered and loaded? YES

All the questions regarding the installation have
now been asked. The installation will now continue
for another 10 minutes.
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%VMSINSTAL-I-RESTORE, Restoring product save set B ...
%SOFTPC-I-COPYFILES, Copying images and required files ...
%SOFTPC-I-COPY75DPI, Copying 75 dpi fonts ...
%SOFTPC-I-COPY75DPI, Copying 75 dpi font sources ...
%SOFTPC-I-COPY100DPI, Copying 100 dpi fonts ...
%SOFTPC-I-COPYUTIL, Copying utilities ...
%SOFTPC-I-COPYHDIMG, Copying hard disk image ...
%SOFTPC-I-ADDHELP, Adding DCL help text ...
%SOFTPC-I-ADDDCL, Adding DCL commands ...
%SOFTPC-I-COPYSTARTUP, Copying startup script ...

A startup procedure for SoftPC has been added to the SYS$STARTUP
directory. This file sets up system wide information for SoftPC
and must be executed by SYSTEM when VMS starts up using:

@SYS$STARTUP:SOFTPC$STARTUP.COM

SoftPC V4.0 Installation is completed.

IMPORTANT NOTE:

Before using SoftPC V4.0, your windows must
be restarted to properly set up the font path.

To do this you must say

$ set def sys$manager
$ @decw$startup restart

%VMSINSTAL-I-MOVEFILES, Files will now be moved to their target directories...
%VMSINSTAL-I-FONTS, Updating font directories
45 fonts loaded
Creating sys$common:[sysfont.decw.user_75dpi]DECW$FONT_DIRECTORY.DAT
45 fonts loaded
Creating sys$common:[sysfont.decw.user_100dpi]DECW$FONT_DIRECTORY.DAT

Beginning SoftPC V4.0 installation verification procedure (IVP) on 7-MAY-1993
09:49:29.16
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SYS$COMMON:[SOFTPC]softpc.exe ................................... OK
SYS$COMMON:[SYSMSG]softpcmsg.exe ................................ OK
SYS$COMMON:[SOFTPC]vmstodos.exe ................................. OK
SYS$COMMON:[SOFTPC]dostovms.exe ................................. OK
SYS$COMMON:[SOFTPC]mkhd.exe ..................................... OK
SYS$COMMON:[SOFTPC]3mb.hdf ...................................... OK
SYS$COMMON:[SOFTPC]SOFTPC.CLD ................................... OK
SYS$STARTUP:softpc$startup.com .................................. OK
SYS$COMMON:[decw$defaults.user]softpc.dat ....................... OK
SYS$COMMON:[SOFTPC]sys.spcconfig ................................ OK
SYS$COMMON:[SOFTPC]ega.rom ...................................... OK
SYS$COMMON:[SOFTPC]v7vga.rom .................................... OK
SYS$COMMON:[SOFTPC]softpc.cld ................................... OK
SYS$COMMON:[SOFTPC]rfloppy.dat .................................. OK
SYS$COMMON:[SOFTPC]spckeys010.a ................................. OK
SYS$COMMON:[SOFTPC]XKBDMAP.INT .................................. OK
SYS$COMMON:[SOFTPC]VT200.INT .................................... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0808E.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0808V.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0814E.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0814H.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0814B.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0814S.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0816C.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0816S.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0816B.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0828S.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1212E.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1212V.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1221E.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1221H.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1221V.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1221B.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1224C.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1224B.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1224S.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1242S.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1608E.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1614E.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1616C.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1616E.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1616B.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1628B.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1628E.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1628H.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1632B.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1632C.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1656S.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC2412E.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC2421E.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC2424C.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC2424B.DECW$FONT .......... OK
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SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC3216E.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC3228E.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC3232B.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC3232C.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0816V.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1224V.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1616V.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1632V.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC2424V.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC3232V.DECW$FONT .......... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0808E.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0808V.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0814E.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0814H.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0814B.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0814S.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0816C.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0816S.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0816B.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0828S.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1212E.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1212V.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1221E.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1221H.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1221V.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1221B.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1224C.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1224B.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1224S.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1242S.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1608E.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1614E.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1616C.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1616E.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1616B.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1628B.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1628E.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1628H.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1632B.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1632C.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1656S.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC2412E.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC2421E.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC2424C.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC2424B.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC3216E.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC3228E.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC3232B.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC3232C.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC0816V.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1224V.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1616V.DECW$bdf ........... OK
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SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC1632V.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC2424V.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_75DPI]SPC3232V.DECW$bdf ........... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC0808E.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC0808V.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC0814E.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC0814H.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC0814B.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC0814S.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC0816C.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC0816S.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC0816B.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC0828S.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1212E.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1212V.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1221E.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1221H.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1221V.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1221B.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1224C.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1224B.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1224S.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1242S.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1608E.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1614E.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1616C.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1616E.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1616B.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1628B.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1628E.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1628H.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1632B.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1632C.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1656S.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC2412E.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC2421E.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC2424C.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC2424B.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC3216E.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC3228E.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC3232B.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC3232C.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC0816V.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1224V.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1616V.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC1632V.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC2424V.DECW$FONT ......... OK
SYS$COMMON:[SYSFONT.DECW.USER_100DPI]SPC3232V.DECW$FONT ......... OK
SYS$COMMON:[SOFTPC]BIOS1.ROM .................................... OK
SYS$COMMON:[SOFTPC]BIOS2.ROM .................................... OK
SYS$COMMON:[SOFTPC]TERM.KEY ..................................... OK
SYS$COMMON:[SOFTPC]XKBDMAP.KEY .................................. OK
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SoftPC IVP completed with 0 error(s).

IMPORTANT NOTE:

Before using SoftPC V4.0, your windows must be restarted to properly set up
the font path.

To do this you must say

$ set def sys$manager
$ @decw$startup restart

Installation of SOFTPC V4.0 completed at 09:51

Enter the products to be processed from the next distribution volume set.
* Products:
VMSINSTAL procedure done at 09:58

$ lo
SYSTEM logged out at 7-MAY-1993 09:58:38.78

A–20 VMS Installation



B
Messages

If DEC SoftPC detects an error condition, an error panel similar
to that shown below displays. The error panel suggests one or
more options. Dimmed options are unavailable. Click MB1 on the
desired action.

Exit

SoftPC Configuration Problem

Error

 

MLO-009949

The configuration file is missing from your
home directory.  Select Default and a copy will
be made from the system default.

Problem File  :  SYS$LOGIN::SPCCONFIG.INI

Default

A continuous RESET state has been entered.
Explanation: An attempt was made to hold the reset line of
the 80286 high. This locks up a real IBM PC/AT.
User Action: Select Reset to reboot SoftPC.

A configuration file entry is duplicated or there is an unrecognized
entry. You may select Default to ignore this entry, or type a
correct entry name and value, then select Continue.
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An installation file required by SoftPC is missing, execution must
terminate.

Could not allocate 16 colors for Windows. You can try stopping
other applications to free color resources, then press
"Continue", or use another colormap by pressing "Default".

Could not allocate 256 colors for Windows. You can try stopping
other applications to free color resources, then press
"Continue": or try to allocate 16 colors by pressing "Default."

Device needed by communications adapter is already being
accessed by another user or is non-local.
User Action: Allocate a different device.

Drive C: & Drive D: cannot be the same file.
User Action: Use a different file for Drive D: or delete Drive
D:.

Extended Memory has not been configured.
Explanation: You tried to use non-existent Extended
Memory.
User Action: Configure Extended Memory as described in
Expanded and Extended Memory.

Failure to allocate the requested number of Expanded Memory
pages.
Explanation: SoftPC allocates memory from the operating
system to support its LIM expanded memory emulation. The
parameters you used to specify the amount of LIM memory
are correct, but the operating system cannot provide sufficient
memory.
User Action: Reduce the amount of memory requested.

File needed by communications adapter is already being accessed
by another user or is non-local.
User Action: Try a different device.

Floppy drive problem. SoftPC cannot access the floppy device.
User Action: Mount a floppy disk drive as described in
Chapter 5.
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Floppy drive problem. The drive is already in use, so it cannot be
used by SoftPC.
User Action: Dismount the floppy drive from another
application.

Illegal drive specification.
User Action: Redefine the device. Be sure to include the
directory, for example, DKA300:.

Internal error in SoftPC procedure.
Explanation: This is a fatal error.
User Action: Reload DEC SoftPC from the distribution tape.
If DEC SoftPC still fails, report the problem as a Software
Performance Report (SPR).

Invalid Auto Flush Delay.
Explanation: The time must be between 1 and 50 seconds.
User Action: Reset the time to a valid number.

Invalid Expanded Memory size.
User Action: Change the Expanded Memory size. See
Chapter 7 for instructions.

Invalid Extended Memory size.
User Action: Change the Extended Memory size. See
Chapter 7 for instructions.

Serial Terminal problem. Graphics mode not available.
Explanation: An attempt was made to run a CGA, EGA,
VGA, or Hercules graphics program. In terminal mode, you
can run only MDA.
User Action: Select an MDA graphics program.

Serial terminal problem. Communications error while writing to
terminal.
User Action: Check your hardware connection.
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Serial terminal problem. SoftPC cannot open the terminfo file to
get the information for $TERM.
Explanation: The terminal environment is set incorrectly.
User Action: Use the command, PRINTENV, to verify all the
environmental parameters.

Serial terminal problem. The port to which your serial terminal is
trying to attach is already in use.
User Action: Try a different device or dismount the device.

Serial terminal problem. The serial terminal port could not be
opened.
User Action: Make sure the device has read and write
privileges.

SlavePC problem. Cannot connect to the PC running SlavePC.
Check the hardware (cable and remote PC) and the settings
(baud rate, parity, etc.) of the SoftPC port you are using.

SlavePC problem. SoftPC cannot use the specified port to
communicate with the remote PC.
Explanation: The communications device cannot be opened
because the port is in use or is being used by another process.

SlavePC problem. SoftPC could not reset the SlavePC program on
the remote PC.
Explanation: SlavePC cannot make connections with the
remote PC.
User Action: Verify that you are using the proper cables and
that they are connected.

SlavePC problem. The port device specified is already in use as a
communications port.
User Action: Specify another port.

SoftPC cannot continue due to insufficient resources from the
Native Language Support message catalogue.
Explanation: DEC SoftPC has been installed incorrectly or
LANG has been defined for another product.

SoftPC does not have access to the CD–ROM device name.
User Action: Set protection on the CD–ROM device.
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SoftPC does not support a ROM BASIC.
Explanation: DOS is trying to boot from a non-bootable C:
drive.
User Action: You forgot to issue the command "MAKEBOOT
1" on that drive. Make it your D: drive and issue MAKEBOOT
1.

The %c: drive is already in use.
Explanation: The FSA device is already in use.
User Action: Use a different FSA drive or release the one in
use.

The %c: drive is not a network drive.
Explanation: The FSA drive selected is not a network drive.

The %c: drive is being used.
Explanation: You are attempting to delete a drive that is not
present.

The CMOS file SPCCMOS.RAM could not be created. (The CMOS
will not be updated.)
User Action: The directory from which you are running DEC
SoftPC must have write privilege.

The CMOS file SPCCMOS.RAM could not be updated. (Continuing
will attempt to create the file in SYS$LOGIN.)
User Action: Click on Continue.

The SoftPC CPU has encountered an illegal instruction.
User Action: DEC SoftPC has been corrupted. Reload DEC
SoftPC from the distribution media.

The communications name is invalid.
User Action: Enter the proper communications name.

The configuration file entry shown below has an invalid value.
You may select Default to replace it with the system default
value, or type a correct value and select Continue.

The configuration file entry shown below is empty. Select Default
to use the system default value, or type a correct value and
select Continue.
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The configuration file in your home directory cannot be written to
by SoftPC.
Explanation: You are either out of disk space or you do not
have write privileges in the directory.
User Action: Increase your disk space or obtain write
privileges.

The configuration file in your home directory has an option with a
bad value.
User Action: Check your configuration file and change the
incorrect value. See Chapter 9.

The configuration file is missing from your home directory. Select
Default and a copy will be made from the system defaults.

The date has been set backward. The PC date may be incorrect.
Explanation: DEC SoftPC was idle during the day change at
midnight so the date did not change.
User Action: Restart DOS or DEC SoftPC.

The date was set forward, or the system was frozen for a period.
The PC date may be incorrect.
Explanation: DEC SoftPC has been frozen during the day
change at 12:00 p.m.
User Action: Restart DOS or DEC SoftPC.

The file named below is not accessible to SoftPC.
User Action: Check the file protection.

The font files could not be opened by SoftPC.
User Action: Reboot the system.

The hard disk cannot be accessed—please check file name and
permissions.
User Action: Change the file protection, if necessary.

The hard disk file cannot be found.
User Action: Verify that the file name is correctly entered
and present in the directory.
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The hard disk file cannot be found.
User Action: Verify that the directory name is correctly
entered and present in the system.

The hard disk file is not a valid hard disk—disk geometry
incorrect.
Explanation: You are trying to access a file that is not a
DEC SoftPC container file.

The hard disk is read only. Another user may be accessing it. If
not, check the permissions.

The hard disk path name is invalid.
User Action: Reenter the path name.

The host computer has no floppy drive that SoftPC can access.

The host filesystem directory cannot be found.
Explanation: The directory name you entered could not be
found.
User Action: Reenter the directory name.

The host filesystem directory must be a directory.
User Action: Reenter with directory name.

The host filesystem directory must have read access.
User Action: Change the protection.

The host filesystem must have read access.
User Action: Set protection to give read access.

The host filesystem name must be a directory.
User Action: Reenter using a directory name.

The keyboard file named below cannot be opened.
User Action: Correct the file name or choose a different file.

The memory resources needed by SoftPC could not be allocated.
Select Continue to retry.
Explanation: The requested extended or expanded memory
exceeds the physical memory available.
User Action: Reduce the requested memory size.
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The new hard disk file could not be created.
Explanation: There is not enough disk space available or
you lack write privilege.
User Action: Reduce the requested disk size. Increase the
disk quota. Change privilege to allow writing.

The port device specified is already in use as the SlavePC port.
User Action: Select a different device.

The sound hardware cannot be accessed. SoftPC will continue
with sound turned off.
User Action: None.

The system default configuration file has a duplicate or
unrecognized entry.
User Action: Correct the configuration file. See Chapter 9.

The system default configuration file has a missing entry.
User Action: Correct the configuration file. See Chapter 9.

The system default configuration file has an invalid value.
User Action: Correct the configuration file. See Chapter 9.

The window manager is not configured to display the requested
video mode.
Explanation: The graphics option requested is not supported
by DEC SoftPC.

Unable to communicate with the terminal.
User Action: Make sure the correct device path name is
specified and that the device is connected.

Unable to open the SlavePC device.
User Action: Check the protection and make sure the full
path name is given, for example, TTA3:.

Unable to select the terminal.
User Action: Check the protection and the proper device
path name.
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Usage: <file name> <size>
Explanation: Incorrect file specification given.
User Action: Use the template example shown.

X Windows System compatibility problem. The visual class is
other than StaticGray, GrayScale, or PseudoColor.
Explanation: DEC SoftPC does not support the graphics
mode of your system.
User Action: None. Your graphics mode is not supported.

mkhd: size must be between 1 and 300.
Explanation: DEC SoftPC supports hard drives from 1 to
300 Mbytes only.
User Action: Enter a size between 1 and 300.

mkhd: unable to create file.
Explanation: File creation failed. You may not have enough
disk space.
User Action: Reduce the size of the drive or delete some files
to increase space.
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C
Insignia Directory Files

This appendix describes the function of each file in the Insignia
directory.

AUTOEXEC.BAT
This .BAT file defines the path name and initiates some SoftPC
programs.

CD–ROM.SYS
This is the driver required for CD–ROMs.

CONFIG.SYS
This is an example of a CONFIG.SYS file that could be used in
the root directory. It is also a copy of the file used on the disk.

EM_DRVR.SYS
This is the driver for the LIM Expanded Memory System.

FLATOG.COM
This file is used in terminal mode to attach a floppy disk to Drive
A:.

FLBTOG.COM
This file is used in terminal mode to attach a floppy disk to Drive
B:.

FLUSHPTS.COM
This file is used to flush the communications ports.

FSADRIVE.COM
This file allocates a drive letter, usually in AUTOEXEC.BAT, for
FSA drives.

HOST.SYS
This is the driver required for FSA drives.
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MAKEBOOT.COM
This file permits you to make a hard disk bootable under DOS
V5.0.

MOUSE.COM
This file installs the Insignia emulation of the Microsoft bus
mouse driver.

OEMSETUP.INF
This is required for adding drivers to Windows V3.1.

ROCKSCR.COM
A PC uses 25 lines while most terminals use 24. This file permits
toggling the 25th line on and off the screen display.

SLAVEPC.EXE
This is a copy of the file on the SlavePC disk in case the original
is damaged or lost.

SPC_EXIT.COM
This file causes you to exit DEC SoftPC.

SPCMSWD
This is the driver set required to run Windows drivers in native
mode.

TOGCOM.COM
This file toggles the communications ports.

TOGSLV.COM
This file toggles SlavePC.
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D
DEC SoftPC’s Serial Port Emulation

This appendix describes the serial port emulation for
communications packages and printers that DEC SoftPC provides.
Communication packages that use the Hayes protocols and
TX/RX can be used successfully. Serial connection to printers is
supported if the driver uses, and the printer supports, XON/XOFF.
Some communication packages that have been tested are:

• SmartComm II

• SmarTerm 220

• Hyperaccess

• Chitchat

• Datatalk

• Procomm

• Crosstalk XVI

Printers that can be used successfully are:

• Apple Laserwriter Plus

• Apple Imagewriter II

(MS–DOS does not inherently support graphics output.)

• Epson FX-105

• Epson SQ-2500

• Epson LQ-2500

• IBM Graphics Printer

(with XON/XOFF)
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Troubleshooting the Serial Port Emulation
The most likely causes of problems with devices and packages
used with DEC SoftPC are described below.

• Devices that do not use RD.

Devices that do not use RD to report their state on the
emulated serial port adapter may cause problems.

This occurs, for example, with an IBM Graphics Printer fitted
with a serial card that does not support XON/XOFF. Because
the IBM Graphics Printer is a relatively slow device, DEC
SoftPC may send characters faster than they can be handled.
The printer does not recognize this condition because the
serial card does not send a detectable response. Using a low
baud rate may help.

• Packages that do not examine RD.

Packages that do not examine RD on the emulated adapter to
detect the state of the device may cause problems.

For example, Crosstalk XVI ignores Hayes responses from the
modem. As a result, the package indicates ‘‘connected’’ as soon
as you start dialing, and the subsequent modem responses
appear as on-screen text rather than being processed by the
package. If you wait for the remote system to respond, the
package should transfer data correctly.

• Hardware devices.

Hardware devices designed to prevent misuse of applications
that depend on accurate timing of signals through the serial
port may not work.

This occurs because the time interval between a transition
on a serial port line and the resulting change of state of
the software signals from the operating system depends on
other activity. These critical times cannot be determined
with sufficient resolution to satisfy the tight time constraints
enforced by some hardware copy protection devices.

• Interaction between the operating system and DEC SoftPC.

At some speeds, the interaction between the operating system
and DEC SoftPC causes unreliable operation. If this happens,
reduce the line speed.
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Serial Port Emulation Limitations
DEC SoftPC does not fully emulate the IBM PC AT serial port
because of limitations in the device drivers that determine the
state of the serial port.

Generally, these limitations:

• Prevent the detection of some types of errors by packages,
particularly those using DSR (data set ready).

• Prevent DEC SoftPC from recognizing when a device responds
to RTS (ready to send).

• Restrict the range of line disciplines you can use.

Figure D–1 diagrams how DEC SoftPC’s serial port emulation
handles the various signals.

Figure D–1 Serial Port Emulation

ULTRIX/VMS Operating System

SoftPC’s Emulated PC/AT Environment

Emulated D-type connector (Serial Port)

TD DTR RTS CTS DCD DSR RX

Real D-type connector

Physical Device

MLO-004315
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Figure D–2 and Figure D–3 illustrate how to make two physical
connections.

Figure D–2 25-pin to 25-pin Physical Connection

1 2 3 4 5 6 7 8 9 10 11 12 13

252423222120191817161514

Comm port for SoftPC

1 2 3 4 5 6 7 8 9 10 11 12 13

252423222120191817161514

Comm port for IBM PC
MLO-006541
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Figure D–3 25-Pin to 9-Pin Physical Connection

1 2 3 4 5 6 7 8 9 10 11 12 13

252423222120191817161514

Comm port for SoftPC

1 2 3 4 5

9876

Comm port for IBM PC
MLO-006540

Note:

• The DTR (data terminal ready) modem output signal loops
back into DSR (data set ready) by software. This means
that devices can detect DTR, but a response from the device
through DSR cannot be detected in DEC SoftPC.

• The RLSD/DCD (received line signal detect/data carrier
detect) modem input signal cannot be detected. The DTR
(data terminal ready) modem signal loops back into
RLSD/DCD by software.

• The RTS (ready to send) modem output signal loops back by
software into CTS (clear to send). This means that devices
can detect RTS, but a response from the device through CTS
cannot be detected by DEC SoftPC.

• The CTS modem input signal cannot be detected. The RTS
modem output signal loops back into this signal by software.

• The RI (ring indicator) modem input signal cannot be detected;
it is forced OFF by software.

• The 2000, 3600, and 7200 baud rates are not available.
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• The line disciplines available in DEC SoftPC are:

Data Bits Parity Stop Bits

8 no 1

7 no 2

7 1 bit 1

(The port in a PC AT can go down to 5 bits with parity.)

On some Digital workstation serial ports, software cannot
change the speed, parity, and number of data bits. DEC
SoftPC, however, behaves as if the request has succeeded, so
the application continues to work. If this happens, you may
need to change the line characteristics manually.

• You cannot detect input overrun and framing errors in the
hardware.

• You cannot detect the existence of an input break condition.

Cabling Guidelines

Connecting a Workstation to a Printer, Terminal, or
Other Computer
A Digital workstation behaves like Data Terminal Equipment
(DTE). You usually need a DTE-DTE cable to connect a Digital
workstation to a printer, terminal, or another computer. This
cable has the data lines crossed over. This means data output
from one side arrives at the input pin on the other side, and vice
versa. Modem control signals are usually crossed over in a similar
manner.

If both the Digital workstation and the serial device have plug
25-pin D-type connectors, a suitable Digital cable is BC22D or
equivalent. The BC22E cable is a DTE-DCE (straight through)
cable.

D–6 DEC SoftPC’s Serial Port Emulation



Connecting a Workstation to a Modem
While most standard modems work with Digital workstations,
cabling can vary from system to system. Table D–1 shows the
cables and adapters needed for various systems.

Table D–1 Connectors

If your workstation has a... Use a...

MMJ H8571-J

25-pin adapter H8571-C connected to a
H8571-J

See your Owner’s Manual or the Digital Terminal and Printers
Handbook for additional information.
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E
VMS File Protection

This appendix discusses file protection for VMS.

Protection codes are based on four categories of users: system,
owner, group, and world. Table E–1 lists the user categories and
access codes.
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Table E–1 Users and Protection Codes—VMS

User Category Type of User

Owner The user who created the file.

Group All users, including the owner, who
have the same group number in their
user identification codes.

World All users.

System All users with system privilege.

Access Type Type of Access

READ The right to examine, print, or copy a
file.

WRITE The right to write (modify) a file.

EXECUTE The right to execute (run) a file.

DELETE The right to delete a file.

Until you, the owner, change a protection code, the system default
protection code is in effect. The system default protection code
follows:

SYSTEM=RWED OWNER=RWED GROUP=RWED WORLD=RE

In the above example, the system, owner, and group have READ,
WRITE, EXECUTE, and DELETE access. World users are
permitted READ and EXECUTE access only.

To find out the protection code for the file MESSAGE.TXT, use the
DIRECTORY/PROTECTION command:

$ DIRECTORY/PROTECTION MESSAGE.TXT RETURN

Directory USER:[SMITH]

MESSAGE.TXT;3 (RD,RWED,RW,R)

Total of 1 file.

In the above example, the system has READ and DELETE access;
the owner has READ, WRITE, EXECUTE, and DELETE access;
the group has READ and WRITE access; and the world has only
READ access.
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To change the protection code, use the SET PROTECTION
command:

$ SET PROTECTION=(SYSTEM:RWE,OWNER:RWED,GROUP:RE) MESSAGE.TXT RETURN

In the above example, you have given the system READ, WRITE,
and EXECUTE access; you the owner READ, WRITE, EXECUTE,
and DELETE access; the group READ and EXECUTE access; and
the world no access. Note that a space must precede your file
name.

It is generally good practice to restrict access of your files to
system and owner. Usually, world access is given only to public
files where many people need to read or copy (READ) files.
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F
Keyboard Mapping

This appendix describes the differences in how the keys are
mapped between your Digital workstation or VT220 terminal
keyboard and a PC keyboard. It also explains how to use the
Digital mouse with DEC SoftPC.

The Keyboard
When you use DEC SoftPC, you must use the Digital terminal
keyboard (Figure F–1) or workstation keyboards (Figure F–2),
(Figure F–3) as though they were a PC keyboard. This section
describes which Digital keys change functions to emulate PC key
functions.
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Figure F–1 Digital VT220 Terminal Keyboard
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Figure F–2 Digital LK201 Workstation Keyboard
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Delete

<

Escape
Right

Ctl

Motif Retains Control of the Left ALT Key
Motif retains control of the left ALT key on the LK201 and LK401
keyboards. This may be a problem if you use Windows because
Windows uses the left ALT key in key sequences such as ALT +
F5 and ALT + F7.

LK201 solution: Use the Motif Window Manager to disable Motif
so that all keystrokes go directly to DEC SoftPC.

LK401 solution: Use the left Compose Character key for left ALT
functions or use the Motif Window Manager to disable Motif so
that all keystrokes go directly to DEC SoftPC.
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Figure F–3 Digital LK401 Workstation Keyboard
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Keyboard Mapping—PC to a Digital Workstation or Terminal
Table F–1 compares the Digital workstation keys and terminal
keyboard keys that function differently with DEC SoftPC.

Table F–1 Key Assignments

PC Keyboard Digital Workstation Digital VT220 Terminal

Break Help F6

Down arrow 2 (keypad) 2 (keypad)

End 1 (keypad) 1 (keypad)

Escape PF4 PF4

F1 F1 F11

F2 F2 F12

F3 F3 F13

F4 F4 F14

F5 F5 F17

F6 F6 F18

F7 F7 F19

F8 F8 F20

F9 F9 F9

F10 F10 F10

Greater than(>) Shift + 9 Shift + 9

(continued on next page)
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Table F–1 (Cont.) Key Assignments

PC Keyboard Digital Workstation Digital VT220 Terminal

Home 7 (keypad) 7 (keypad)

Insert 0 (keypad) 0 (keypad)

Left arrow 4 (keypad) 4 (keypad)

Less than (<) Shifted comma Shift +, (main keyboard)

Left shift Shift Insert here

Num lock PF1 PF1

Page down 3 (keypad) 3 (keypad)

Page up 9 (keypad) 9 (keypad)

Print screen F13 Help

Right arrow 6 (keypad) 6 (keypad)

Right shift F20 Prev screen

Scroll lock F14 Do

Slash (/) PF2 PF2
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Keyboard Mapping—Digital Workstation to PC
Table F–2 shows the Digital workstation keyboard keys mapped
to the PC keyboard in increasing Digital scan code order.

Table F–2 Key Assignments for Digital Workstations

Digital Workstation PC Keyboard

F1 F1

F2 F2

F3 F3

F4 F4

F5 F5

F6 F6

F7 F7

F8 F8

F9 F9

F10 F10

F11 F11

F12 F12

F13 Print Screen

F14 Scroll Lock

Help Break

F17 F17

F18 Right Control

F19 Right Alt

F20 Right Shift

Find Insert

Insert Home

Remove Page Up

Select Delete

Prev End

Next Page Down

(continued on next page)
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Table F–2 (Cont.) Key Assignments for Digital Workstations

Digital Workstation PC Keyboard

Numeric Keypad

0 Insert

.(period) Delete

Enter Enter

1 End

2 Down Arrow

3 Page Down

4 Left Arrow

5 5

6 Right Arrow

,(comma) +

7 Home

8 Up Arrow

9 Page Up

– -

PF1 Num Lock

PF2 /

PF3 *

PF7 escape

Cursor Keys

Left Arrow Left Arrow

Right Arrow Right Arrow

Down Arrow Down Arrow

Up Arrow Up Arrow

(continued on next page)
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Table F–2 (Cont.) Key Assignments for Digital Workstations

Digital Workstation PC Keyboard

Special Control Keys

Shift Left Shift

Control Left Control

Lock Caps Lock

Compose Left Alt

Del Erase

The remaining keys on the Digital workstation and PC keyboard
are identical.

The Mouse
MB1 is equivalent to the PC left mouse button. MB2 is used to
paste text in another window. MB3 is equivalent to the PC right
mouse button.

MB2

MB1
(PC Left

Mouse Button)

MB3
(PC Right

Mouse Button)

MLO-009957
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A
A: drive, 4–4
Activating

Drive A: or B:, 5–4
Attaching

Drive A: or B:, 5–4
mouse, 2–4
SlavePC, 4–8

Auto Flush, 6–5
Auto Freeze, 2–6
AUTOEXEC.BAT file, 3–14

B
B: drive, 4–4

C
C: drive, 3–1

copying, 4–2
CGA, 1–2, 7–2
Changing

display type, 7–1
Changing Display type

on terminal, 9–6
Characters

illegal in DOS file names, 8–4
COM port 1, 6–1
COM port 2, 6–1
COM port entries, 10–5
COM type entries, 10–5
Communications port emulation, D–1

CONFIG.SYS file, 3–13
Configuration file, 10–3

editing, 9–5
Connecting to a computer, D–6
Connecting to a modem, D–7
Connecting to a printer, D–6
Connecting to a terminal, D–6
Conventions

used in this manual, xi
Converting files

DOS to VMS, 8–3
VMS to DOS, 8–3

Copy and paste, 2–5
Copy-protected software, 8–3
Copying

existing hard disk, 3–3
Copying files

DOS to VMS, 8–3
VMS to DOS, 8–3

Creating hard disk, 3–2
Ctrl/Alt/Del, 2–5
Cursor

disappearing, 2–5
Cut and paste, 2–5

D
D: drive, 3–2

copying, 4–2
DEC SoftPC

on terminals, 9–1
Detaching

SlavePC, 4–9
Diskettes, 4–1

See Floppy disks
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Display type, 7–1
DOS

illegal file names, 8–4
running, 2–2

Drive A:
attaching, 9–6

Drive A: and B:, 4–4
Drive A: or B:

activating, 5–4
attaching, 5–4

Drive B:
attaching, 9–6

Drive C:, 3–1
copying, 4–2

Drive D:, 3–2
copying, 4–2

Drive names
on terminal, 9–7

Drive types, 3–1
Drivers installing native-mode, 10–1
Drives E: - Z:, 8–1

file formats, 8–3
VMS naming conventions, 8–4

E
E: drive, 8–1
Edit, 2–5
EGA, 1–2, 7–2
Error messages, B–1
Exit, 2–4
Expanded memory, 7–3

F
File names

VMS, 8–4
File protection

VMS, E–1
Fixed disks

See Hard disks
Floppy disks, 4–1, 5–1

finding name, 5–1
formatting, 5–3

Floppy drives, 4–1, 5–1
Flush buffers, 6–6
Flush printer procedure

on terminal, 9–4
Formatting

floppy disks, 4–4
FPU emulation, 2–7
Freeze, 1–2
Freeze/unfreeze, 2–6
FSA (File Sharing Architecture), 8–1

restrictions, 8–2
FSA Root Directory, 3–2

H
Hard disk

terminals, 9–7
Hard disks

creating, 3–2
Hercules, 1–2, 7–2

I
Initialization file, 10–3
Initializing floppy disk, 5–3
Insignia Directory, C–1
Installation

of SoftPC, A–1
sample VMS, A–15

K
Keyboard, F–1

functions in MS–DOS, F–7
functions in DOS, F–5

Keyboard mapping, F–5
workstation to PC, F–6

L
LIM (Lotus, Intel, Microsoft) Expanded

Memory System, 1–2, 7–3
LMF (License Management Facility), A–4
LPT, 6–1
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M
Main Menu, 2–3

accessing, 2–2
freeze DEC SoftPC/unfreeze DEC SoftPC,

2–6
restart, 2–5
switch sound on, 2–7

MDA, 9–6
Messages

SoftPC, B–1
Modems

connecting, 6–1, D–7
Mouse

attaching, 2–4
detaching, 2–5
using, F–9

MS–DOS
mouse, F–9
opening window, 2–2
printing files, 6–2
starting, 2–2

MS–DOS drives, 4–1, 5–1

N
NFS, 8–1

O
Opening window, 2–2

P
PAK (Product Authorization Key), A–4
Paste, 2–5
Permissions

VMS, E–1
Printer port emulation, D–1
Printers

connecting, 6–1
Printing a file

on terminal, 9–4
Protection

VMS, E–1

R
Reboot, 2–5
Release notes

VMS, A–8
Resizing window, 2–4
Restarting DEC SoftPC, 2–5
Running DEC SoftPC, 2–2
Running DOS, 2–2
RX23, 4–4
RX33, 4–4

S
Serial port

emulation, D–1
SlavePC, 4–1, 5–1

attaching, 4–8
definition, 4–5
detaching, 4–9
uses, 4–5

SoftPC
configuration file, 10–3
edit, 2–5
exit, 2–4
features, 1–1
initialization file, 10–3
installing, A–1
Main Menu, 2–3
messages, B–1
starting, 2–2

Sound, 2–7
Switch sound on, 2–7

T
Terminal

configuring, 9–7
for SoftPC, 9–7

SoftPC on, 9–1
Troubleshooting

printer port, D–2
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V
VAXcluster

installing SoftPC, A–11
VGA, 7–2
VMS

installing SoftPC, A–1

on terminals, 9–1
release notes, A–8

W
Window

opening, 2–2
resizing, 2–4

Windows, increasing speed of, 10–1
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